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Preface

The purpose of this guide is to help you administrate Operations Analytics
Predictive Insights Managed.

Provided in this guide is a reference section describing the Operations Analytics
Predictive Insights Managed command line interface (CLI) as well as the available
configuration properties. The guide also contains instructions on how to perform
common administration tasks.

Audience
The audience for this guide is the network administrator or operations specialist
responsible for the administration of Operations Analytics Predictive Insights
Managed.

To administrate Operations Analytics Predictive Insights Managed you must have
an advanced understanding of the following subjects:
v Administration of the Linux operating system
v Administration of IBM InfoSphere Streams
v Administration of the DB2 database management system
v Tivoli Integrated Portal
v Operations Analytics Predictive Insights Managed

Components
IBM® Operations Analytics Predictive Insights Managed consists of four main
components.

The IBM Operations Analytics Predictive Insights Managed components are:
v The Database component: is used to store configuration data, metadata and

metric data.
v The Analytic component: performs data mediation and processes incoming data

to discover any anomalies that are present.
v The UI component: presents any discovered anomalies through the IBM

Dashboard Application Services Hub application or the IBM Tivoli Integrated
Portal application.

v The Mediation tool: is used to configure a data source and the data model that
Operations Analytics Predictive Insights Managed will monitor.

Operations Analytics Predictive Insights Managed documentation includes the
following guides:
v Release notes
v Installation Guide
v Upgrade Guide
v Administration Guide
v Error Messages Guide

© Copyright IBM Corp. 2011, 2016 v
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Chapter 1. Initial configuration of Operations Analytics
Predictive Insights Managed

After you install Operations Analytics Predictive Insights Managed, you must
perform configuration tasks to set up the system.

Configuring user access to Operations Analytics Predictive Insights
Managed

You must grant users access to the Operations Analytics Predictive Insights
Managed User Interface so they can view anomaly information.

Dashboard Application Services Hub
If you installed Operations Analytics Predictive Insights Managed into Dashboard
Application Services Hub, you must configure access to the Operations Analytics
Predictive Insights Managed User Interface (UI) for users of Dashboard Application
Services Hub.

About this task

You must create users in OMNIbus WebGUI and grant the users access to the
Operations Analytics Predictive Insights Managed (UI). This topic provides a
summary of the steps to create users and add users to groups in OMNIbus
WebGUI. For more information, see Administering users, roles, and groups and
Creating and editing groups in the Tivoli Netcool/OMNIbus Knowledge Center.

Procedure
1. Create users in OMNIbus WebGUI.

a. Log in to Dashboard Application Services Hub as an administrative user.
b. Click WebSphere Administrative Console under the Console Settings

folder.
c. In the new page that is opened, click the Launch WebSphere

administrative console button.
The WebSphere Integrated Solutions Console is launched in a new browser
tab.

d. Log in using the Dashboard Application Services Hub profile username and
password.

e. Click Users and Groups.
f. Click Manage Users.
g. Click Create.

2. Use one of the following methods to grant the WebGUI users access to the
Operations Analytics Predictive Insights Managed UI:
v Add the new users to an existing group that has the netcool_rw role. The

netcool_rw role grants users the rights to launch the Service Diagnosis and
View Child Alarms menu options in the Active Event List and the Event
Viewer. For example, complete steps a to g to add users to the
Netcool_Omnibus_Admin group, which has the netcool_rw role by default.

© Copyright IBM Corp. 2011, 2016 1
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a. In the WebSphere Integrated Solutions Console, click Users and Groups to
expand this section.

b. Click the Manage Groups task.
c. Click the appropriate group, for example, Netcool_Omnibus_Admin.
d. Click Members.
e. Click Add Users.
f. In the Search for box, enter a user name or use '*' and click Search.
g. Select the user and click Add.
v Create a group in OMNIbus WebGUI, add the Netcool_rw role to the group,

and add users to the group. For information on how to configure groups in
OMNIbus WebGUI, see Creating and editing groups in the Tivoli
Netcool/OMNIbus Knowledge Center. After you configure the group,
complete the following steps to grant the group members rights to access the
Operations Analytics Predictive Insights Managed UI. Users can access the
UI from the Service Diagnosis and View Child Alarms menu options in the
Active Event List and the Event Viewer.

a. Log on to the server on which you installed the Operations Analytics
Predictive Insights Managed UI as the user that installed the UI.

b. Navigate to the <Liberty_Install_Home>/UI/bin directory. The default path
for <Liberty_Install_Home> is /opt/IBM/scanalytics.

c. Enter the following command to grant access to the Operations Analytics
Predictive Insights Managed User Interface:
./addAccess.sh <user | group> <user or group name>

For example, to grant access to a group called operators, enter the
following:
./addAccess.sh group operators

Note: The addAccess.sh script authorizes users on the Liberty Profile but
does not configure user roles in WebGUI.

What to do next

If you need to remove access for a specific user or group, use the following
command:
removeAccess.sh <user | group> <user or group name>

For example:
removeAccesss.sh group operators

Tivoli Integrated Portal
If you installed Operations Analytics Predictive Insights Managed into a Tivoli
Integrated Portal environment, you must configure access to the Operations
Analytics Predictive Insights Managed User Interface (UI) for users of Tivoli
Integrated Portal.

About this task

Complete this task only if you installed Operations Analytics Predictive Insights
Managed into a Tivoli Integrated Portal environment.
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Configuring OMNIbus WebGUI users
In order for users to be able to use the Active Event List to monitor events, they
must be given permissions to access the WebGUI tools.

About this task

Complete this task only if you installed Operations Analytics Predictive Insights
Managed into a Tivoli Integrated Portal environment.

Procedure
v Follow these steps to assign WebGUI permissions to tipadmin:

1. Log in to Tivoli® Integrated Portal as tipadmin.
You can access Tivoli Integrated Portal in your browser, for example:
https://<hostname>:16311/ibm/console

2. Click Users and Groups > User Roles.
3. Click Search and select tipadmin.
4. Select the following options and click Save:

– ncw_admin

– netcool_rw

5. Click Logout.
6. Log back in as tipadmin.
7. In the navigation pane, you can see extra entries that include Administration

and Availability.
8. Operations Analytics Predictive Insights Managed sends events to the Active

Event List, which can be found at Availability > Events > Active Event List
(AEL).

v Follow these steps to assign WebGUI permissions to all users that are not
tipadmin:
1. Log in to Tivoli Integrated Portal as tipadmin.
2. Change to Users and Groups > Manage Users.
3. Enter the relevant user ID and click Search.
4. Click the user that is displayed in the table.
5. Click the Groups tab.
6. Click Add.
7. Click Search to see the list of groups.
8. Assign the user to one of the following groups, as appropriate for the user.

– Administrative Users: Netcool_OMNIbus_Admin

– Ordinary Users: Netcool_OMNIbus_User

9. Click Add.
10. Click Close.

Note: To make the Operations Analytics Predictive Insights Managed action
script available you must have a user with Netcool_OMNIbus_Admin
permissions.

Configuring roles and groups in Tivoli Integrated Portal
Tivoli Integrated Portal users must have the correct roles and groups to manage
user access to Operations Analytics Predictive Insights Managed.
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About this task

Complete this task only if you installed Operations Analytics Predictive Insights
Managed into a Tivoli Integrated Portal environment.

To access the Operations Analytics Predictive Insights Managed UI, users must be
members of a group that is assigned an Operations Analytics Predictive Insights
Managed role, that is, predictiveInsightsUser or predictiveInsightsAdmin. The
difference between both roles is that the predictiveInsightsAdmin user can export
data in both streamlation and CSV formats while the predictiveInsightsUser can
export only in CSV format.

The predictiveInsightsUser and predictiveInsightsAdmin roles, and the
predictiveInsightsUsers and predictiveInsightsAdmins groups are added
automatically when Operations Analytics Predictive Insights Managed is installed.

Procedure

As tipadmin add the ncw_user role to the predictiveInsightsUsers group.
For information about how to assign roles to groups, open the Tivoli Integrated
Portal online help and change to Tivoli Integrated Portal > Administrative
settings > Working with roles

Configuring user accounts in Tivoli Integrated Portal
To have access to the Operations Analytics Predictive Insights Managed User
Interface, a user must be assigned to the Operations Analytics Predictive Insights
Managed roles or groups.

Before you begin

Complete this task only if you installed Operations Analytics Predictive Insights
Managed into a Tivoli Integrated Portal environment.

The Tivoli Integrated Portal Administrator can add users through the Users &
Groups function in the navigation pane.

About this task

For example, to assign a user to the predictiveInsightsUsers group:

Procedure
1. Log in as the Tivoli Integrated Portal admin user. For example, log in as

tipadmin.
2. Click Users & Groups > Manage Groups.
3. Select the user that you want to give access to the Operations Analytics

Predictive Insights Managed UI.
4. Assign the group predictiveInsightsUsers to the selected user.
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Setting the DB2 log file size
Instructions on how to set the DB2 log file size to suit your Operations Analytics
Predictive Insights Managed installation.

About this task

The DB2 log file size settings described in this section have been optimized for a
Operations Analytics Predictive Insights Managed installation with a KPI count of
100,000.

Procedure
1. As the Operations Analytics Predictive Insights Managed database owner,

typically db2inst1 log into the Operations Analytics Predictive Insights
Managed database server.

2. Update Operations Analytics Predictive Insights Managed database
configuration by setting LOGBUFSZ to be 4096.
You can get details on each DB2 configuration parameter by opening the DB2
Knowledge Center and searching for the relevant configuration parameter.

3. Update Operations Analytics Predictive Insights Managed database
configuration by setting LOGFILSIZ to be 8102.

4. Update Operations Analytics Predictive Insights Managed database
configuration by setting LOGPRIMARY to be 100.

5. Update Operations Analytics Predictive Insights Managed database
configuration by setting LOGSECOND to be 75.

What to do next

To optimize IO performance, update the transaction logs to use a disk that has low
IO and is separate to the database. For details on how to update the transaction
logs, open the DB2 Knowledge Center and search for the section newlogpath -
Change the database log path configuration parameter.

Configuring DB2 to allow for the processing of many metric groups
DB2 must be configured so that it is able to support the processing of metric data
for more than fifty groups.

About this task

If Operations Analytics Predictive Insights Managed is used to monitor more than
fifty metric groups, that is, your data sources contain in excess of fifty metric
groups, you must configure DB2 to be able to support that number.

DB2 is configured to support an increased number of metric groups by changing
the maximum number of active applications allowed for that instance.

To configure DB2:

Procedure
1. As the as the Operations Analytics Predictive Insights Managed database

owner, typically db2inst1 log into the Operations Analytics Predictive Insights
Managed database server.

2. Run the following command:
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db2 get db cfg for SCAPIDB | grep MAXAPPLS
Max number of active applications (MAXAPPLS) = AUTOMATIC(92)

You can see from this the current level of supported active applications.
3. Increase the number of supported active applications to 400 using the

command:
db2 update db cfg for SCAPIDB using MAXAPPLS 400

Scheduling cleanup of the Analytics folder
Schedule a maintenance job that compresses old topic files.

About this task

The purpose of this task is to schedule a maintenance job that compresses files in
the analytics folder that are two days old and older.

This task describes how to schedule the maintenance job with cron, but you can
use any scheduling application. You must schedule two jobs.
v One maintenance job compresses all the csv files created during extraction or

merge after a period two days. The job uses "*.csv*" to include the .csv.good and
the .csv.bad files.

v The other maintenance job deletes the compressed files after 60 days.

Both of the maintenance jobs must be added as the scadmin user.

The following is an example procedure, which schedules the maintenance jobs to
run at 12:05 am and 12:15 am every night

Procedure
1. On the analytics server, log in as the scadmin user.
2. Edit the cron table to include the two jobs:

5 0 * * * export PI_HOME=/opt/IBM/scanalytics/analytics;
/bin/find $PI_HOME/var -type f \( -name "*.csv" -o -name "*.csv.bad" \)
-mtime +2 |xargs gzip

15 0 * * * export PI_HOME=/opt/IBM/scanalytics/analytics;
/bin/find $PI_HOME/var -type f \( -name "*csv.gz" -o -name "*.csv.bad.gz" \)
-mtime +60 | xargs rm -f

Where:
$PI_HOME is set to be the installation location of the analytics component.

Preparing your system for unplanned shut down
It is good practice to prepare your system for the event of a forced restart.

About this task

It is good practice to configure your Operations Analytics Predictive Insights
Managed system to use the following reboot commands. The following
configuration items ensure the set of hosted Operations Analytics Predictive
Insights Managed components restart correctly should your system experience an
unplanned shut down.

6 IBM Operations Analytics Predictive Insights Managed: Configuration and Administration Guide



Procedure
v Before restarting the Database server, prepare for restart of the Database

component:
1. Add a database start command in the crontab of the DB2 owner:

@reboot source /home/db2inst1/sqllib/db2profile; db2start

For example, as db2inst1 run
crontab -e

and insert the line
@reboot source /home/db2inst1/sqllib/db2profile; db2start

2. Add a database start command in the crontab of the DB2 DAS owner if
applicable:
@reboot source /home/dasusr1/das/dasprofile; db2admin start

For example, as dasusr1 run
crontab -e

and insert the line
@reboot source /home/dasusr1/das/dasprofile; db2admin start

v Before restarting the Analytics server, prepare for restart of the Analytics
component:
Add a Streams start command in the crontab of the InfoSphere Streams owner:
@reboot source ~/.bashrc; streamtool stopinstance -i spl --force; streamtool
rminstance -i spl --noprompt

For example, as scadmin run
crontab -e

and insert the line
@reboot source ~/.bashrc; streamtool stopinstance -i spl --force; streamtool
rminstance -i spl --noprompt

v Before restarting the OMNIbus server, prepare for restart of the object server:
Add an object server start command in the crontab of the OMNIbus owner:
@reboot nohup /opt/IBM/tivoli/netcool/omnibus/bin/nco_objserv

For example, as scadmin run
crontab -e

and insert the line
@reboot nohup /opt/IBM/tivoli/netcool/omnibus/bin/nco_objserv

v Before restarting the UI server, prepare for restart of the UI component

Dashboard Application Services Hub

If you are using Dashboard Applications Services Hub, on the Jazz for Service
Management server, add the following command to the crontab of the user that
installed Jazz for Service Management:
@reboot source ~/.bashrc; /opt/IBM/JazzSM/profile/bin/startServer.sh server1

On the Operations Analytics Predictive Insights Managed UI server, which may
be the same as the Jazz for Service Management Server, add the following
command to the crontab of the user that installed the UI component:
@reboot source ~/.bashrc; sleep 2m; /opt/IBM/scanalytics/UI/bin/pi.sh -start

Note: For a distributed configuration where Dashboard Applications Services
Hub and the Operations Analytics Predictive Insights Managed UI component
are on separate servers, if the Operations Analytics Predictive Insights Managed
UI server comes online before the Dashboard Applications Services Hub server,
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then federation into Dashboard Applications Services Hub may not come up
correctly. In this case, a further restart of the Operations Analytics Predictive
Insights Managed UI may be necessary:
/opt/IBM/scanalytics/UI/bin/pi.sh -restart

Tivoli Integrated Portal

If you are using Tivoli Integrated Portal, add the following command to the
crontab of the user that installed the application:
@reboot /opt/IBM/tivoli/tipv2/profiles/TIPProfile/bin/startServer.sh server1

For example, if you are using Tivoli Integrated Portal, as scadmin run
crontab -e

and insert the line
@reboot /opt/IBM/tivoli/tipv2/profiles/TIPProfile/bin/startServer.sh server1

Adding database drivers
If the database you are selecting as a data source is not a DB2 database, you must
add the required database drivers. You do not require any database drivers if you
are using a file system as your data source.

Adding database drivers to the Mediation Tool
To allow data extraction from a database other than DB2, the driver for which is
preinstalled, you must add the appropriate database driver to the Mediation tool.

About this task

After you add a database drivers to the Mediation tool, you will then be able to
select the drivers when you configure your data source.

Procedure
1. Ensure that the database driver is saved on your local drive.
2. Start the Operations Analytics Predictive Insights Managed Mediation tool by

running the Eclipse application.
a. Navigate to the directory /opt/IBM/scanalytics/mediationtool/eclipse.
b. Run ./eclipse
On startup, you are asked to specify a workspace location.
This workspace does not have any special requirements. It is a folder in which
your mediation files are kept, so you can keep it local to the Operations
Analytics Predictive Insights Managed Mediation tool installation or to a
directory where you have write access.

Note: Do not set the workspace location to the folder where the Mediation Tool
is installed, /opt/IBM/scanalytics/mediationtool/eclipse, to ensure that the
workspace is not deleted in the event that you uninstall the Mediation tool.

3. Click Window > Preferences > Predictive Insights > New.
4. Select the driver location and click Apply. Eclipse requests that it is restarted.
5. Click OK.
6. By default, the following drivers are preconfigured in the Medation tool:

Oracle, MySQL, Sybase, and Microsoft SQL. If you add a driver that is not
preconfigured in the Mediation tool, you must complete steps 1 to 5 to add the
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driver. Note that the complete JDBC driver must be contained in a single jar
file. After you add the driver, you must also complete the following steps to
configure the driver's properties.
a. Using an editor, create a driver.properties file in the workspace location that

you specified when you started the Mediation tool. For example,
/eclipse/workspace/driver.properties.

b. For each database driver, add the following lines to the driver.properties
file:
<driver_name>.caption=Undefined Driver
<driver_name>.url=jdbc://<host>:<port>/<database> <other_properties>
<driver_name>.port=<port>

where:
v driver name is the name of the JDBC database driver
v host is the host name of the system where the database is located and is

mandatory
v port is the port number on which the database listens and is optional
v database is the name of the database and is optional
v other_properties are custom properties for individual drivers

For example:
com.microsoft.sqlserver.jdbc.SQLServerDriver.caption = Microsoft JDBC
SQL server
com.microsoft.sqlserver.jdbc.SQLServerDriver.url = jdbc:sqlserver://
{host}:{port};databaseName={database}
com.microsoft.sqlserver.jdbc.SQLServerDriver.port = 1433

Note: If a <driver_name>.url field, in the driver.properties file, contains
properties other than host, port, and database, these additional properties
will appear in the URL field in the Mediation Tool. You must click the
Custom checkbox beside the URL field and edit the URL to remove the
additional properties.

c. Restart the Mediation tool to make the driver available when you connect to
the data source.

Adding database drivers to the Analytics server
For extraction to take place from a database other than a DB2 database, you must
add the database driver to the $PI_HOME/lib directory before you start Operations
Analytics Predictive Insights Managed.

Procedure
1. Log in to server on which your analytics instance is installed.
2. Ensure that your database drivers are copied to the same server.
3. Place the driver files in the $PI_HOME/lib directory.

Where $PI_HOME is the installation location of the analytics component.
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Chapter 2. Configuring mediation

Mediation is the process of defining which data Operations Analytics Predictive
Insights Managed analyzes.

The following is a summary of the steps required to configure mediation.
1. Start the Mediation tool.
2. Create a project.
3. Add one or more data sources.
4. Create a model.

a. Synchronize with the data source
b. Select the data elements that you want to form your model
c. Configure the model by editing the Group Definition, Attributes, and

Metrics
d. Save and validate the model.

5. Deploy the model.

Each of these steps is described in detail in the following sections.

Starting the Mediation tool
Start the Operations Analytics Predictive Insights Managed Mediation tool by
running the Eclipse application.

Before you begin

You cannot start the Mediation tool successfully from the terminal window that
you use to install the Mediation tool. You must start the Mediation tool in a new
terminal window so that the environment variables that the Mediation tool
requires to run are set.

Procedure
1. As scadmin, log on to the server on which you installed the Operations

Analytics Predictive Insights Managed Mediation tool.
2. Navigate to the directory $PI_HOME/bin.
3. Run ./mediationtool.sh

At startup, you are asked to specify a workspace location. This workspace is a
folder in which your mediation files are kept.

Note: If you upgraded from an earlier version of Operations Analytics
Predictive Insights Managed and you specify a workspace location that was
used by a previous version of the Mediation Tool, you see the following
message:
Workspace was written with an older version of the product and will be
updated. Updating the workspace can make it incompatible with older
versions of the product. You can choose OK to use the existing workspace.
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Creating an Operations Analytics Predictive Insights Managed project
Instructions on how to create a new project with the Operations Analytics
Predictive Insights Managed Mediation tool.

About this task

A project is a container that store details of data sources and models configured in
the Mediation tool.

Procedure
1. Open the Operations Analytics Predictive Insights Managed Mediation tool.
2. When you first open the Mediation tool, you are presented with a welcome

screen. Close the welcome tab.
If you want to restore it later, you can select Help > Welcome.

3. Click File > New > Project. The New Project dialog box is opened, and you
must choose the wizard you are going to use to create the new project element.

4. In the New Project dialog box, select the Predictive Insights Wizards >
Predictive Insights Project option and click Next.

5. Enter a name for your new project into the Project name field.
6. Enter a location for your new project within the Location field or use the

default.
7. Click Finish.
8. Select Yes if prompted to associate the project with a Predictive Insights

perspective.

Results

You now have a new empty project.

Adding a data source to a project
You can choose from two types of data source for a model, a file-based data source
or database data source.

About this task

The Operations Analytics Predictive Insights Managed Mediation tool provides a
wizard to help you add and configure a data source. A data source and a model
configuration combine to form a Operations Analytics Predictive Insights Managed
model.

While you must add separate data sources to your project for separate databases
and file systems, you must also make sure that each data source only covers one
timezone. Multiple timezones per data source are not permitted. If a database or
filesystem covers multiple timezones, you must add a data source for each
timezone that is covered to include all data.

Procedure
1. In the Operations Analytics Predictive Insights Managed Mediation tool,

right-click your new project and select New > Predictive Insights Data Source.
The New Predictive Insights Data Source dialog is displayed.

2. Select the project in which you want the model to be saved.
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3. Enter a name for the data source configuration.
The file name must retain the .pamodel file extension.

4. Click Next.
5. Select the data source type, which can be either Database or File System.
6. The XML Encoding drop-down menu sets the encoding that is applied to the

configuration file you are creating.
7. Choose the data format for the data source. The default format requires that the

data source has metric names located in column headers. If the metric names
are contained in rows of data, click the radio button beside Metric names in
rows.

8. Click Finish. The Operations Analytics Predictive Insights Managed Mediation
tool now displays the connection details for the new data source.

What to do next

You now have a data source item for your model. The appropriate editor is opened
in order for you to complete the connection to your database or file system.

If you are adding a file system as a data source, see “Adding a file system data
source”

If you are adding a database as a data source, see “Adding database drivers” on
page 8 and then “Adding a database data source” on page 19.

Adding a file system data source
When you added a data source for your project, you selected the file system type.

Before you begin

If you installed the Mediation tool on a different system to the Analytics
component, do the following:
v Set up an environment variable to mask the differences between the file system

data source path on the server that hosts the Mediation tool and the file system
data source path on the server that hosts the Analytics component.

v Copy CSV files representing at least one full day of data to the server that hosts
the Mediation tool so you can preview the configuration before and during
deployment.

The File Path parameter, which you set when you add a file system data source,
supports the use of environment variables. If the server on which you are running
the Mediation tool is the same as the Analytics server, you do not need to create an
environment variable.

One or more path environment variables can be used in the File Path element of a
Operations Analytics Predictive Insights Managed data source for files extraction.
Any environment variables that are entered into the File Path field are resolved
against the environment of the operating system that hosts the UI or the Extractor
instance.

If the Operations Analytics Predictive Insights Managed Mediation tool is running
on Windows:
1. Create an environment variable, such as, %MY_AGENT%.
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2. Set the environment variable to a valid local path, which points to the location
of the files for extraction.

3. Restart the Operations Analytics Predictive Insights Managed Mediation tool in
order to make the new variable visible to the UI process.

If the Operations Analytics Predictive Insights Managed Mediation tool is running
on Linux:
1. Create an environment variable, such as, $MY_AGENT.
2. Set the environment variable to a valid local path, which points to the location

of the files for extraction.
3. Add the environment variable to the user's.bashrc file.
4. Restart the Operations Analytics Predictive Insights Managed Mediation tool in

order to make the new variable visible to the UI process.

For the Extractor, which can run only on Linux, as it must run on the same server
as the Analytics component, the same applies: The $MY_AGENT variable must be
properly exported to make it visible to the next running Extractor instance.

Note: It is assumed that the file system or a copy of that file system exists locally
in the directory corresponding to that path.

About this task

To create a file system data source configuration, you must enter details of that file
system in the File System Details tab. Note the following when you update the
File System Details tab:

Note: For information on the rules that are related to file naming, csv file format
and file content, see the section Mediation tool reference
v Set the File Path to the path that contains the file system data source.

Enter the path in Unix/Linux notation, that is, without drive letter and with
forward slashes. Use Unix/Linux notation regardless of whether you are
creating your configuration on a Windows server or a Linux server. It is
assumed that the file system or a copy of that file system exists locally in the
directory corresponding to that path. You can use an environment variable to
make the File Path setting more portable.

Note: For file based data sources, you can create only one metric group per
table within that data source. Creating multiple metric groups per table results
in a deadlock situation. If you need to have multiple metric groups for a table,
you must deliver the source file data to separate file system directories, and
create one data source definition per directory.
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For both Windows and Linux, if you are referring to an environment variable in
the File Path field, use Unix/Linux notation, for example, $MY_AGENT.

v Use the Name Pattern to enter a regular expression that filters the files that are
contained in the file path specified. The regular expression must have at least
two capturing groups, the second of which matches a timestamp or write time.
The default of ([a-zA-Z]\w*)__(\d{16})__(\d{16}).*\.csv has three matching
groups. The first matching group is expected to be the metric group name, the
second is the start time, and the third is the end time; for example,
Disk_1130421121500000_1130421123000000.csv

Note: For more information on file patterns, see “Example file naming patterns”
on page 18

v Set the Time Format to a string that matches the format of the date and time
used in the CSV file names, for example, 1yyMMddHHmmssSSS
The formats allowable are defined by the SimpleDateFormat Java™ class. For
more information about the SimpleDateFormat Java class, see
http://docs.oracle.com/javase/7/docs/api/java/text/SimpleDateFormat.html.

v Use the Time Zone to specify which time zone the data source is from. You
must consider the time zone of the time stamps in both the source file names
and the data:
– If the time stamps in the file names and data are for the same time zone,

select that time zone.
– If the time stamps in the file names and data are for different time zones, the

time stamps in either the file names or the data must include a timezone
identifier. In the Time Zone field, select the time zone that is not identified in
either the file names or the data time stamps. For example, if the time zone in
the file names is EST but the time zone is not shown and the time zone in the
data is CST and the time zone is shown, set the Time Zone field to EST.

– If the time zone in the file name and data are for different time zones and the
time zone is shown in both time stamps, set the time zone to that shown in
the file name time stamps.

For examples on how to configure Operations Analytics Predictive Insights
Managed for different time zones, see “CSV file names and data are for different
time zones” on page 26
All data extracted by Operations Analytics Predictive Insights Managed is
loaded into the Operations Analytics Predictive Insights Managed database in
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UTC time. Therefore, if you can set the time zone of the source data, it is
recommended that you set it to UTC for both the file names and data.
If the timezone the data is coming from applies DST, timestamps in both file
names and data must include a time offset or timezone. If some of your file
names and data timestamps already have timezone or time offset information,
you can still set the timezone for the data source, but Operations Analytics
Predictive Insights Managed gives priority to the time related information
contained in the data.
Only one timezone is supported per model. If the CSV file names or the data
within the files represent different time zones, the files for each different time
zone must be in separate directories and you must create a separate model for
each set of source files.

v Click Test Matching to confirm the file set that matches your expression.

Procedure
1. Update the fields within the File System Details tab.
2. Click File > Save.
3. Check for any issues with your data source by opening the Problems tab. As

you need to complete further steps to make that data source valid, an error
message is displayed within the Problems tab. The error message disappears
when you complete the data source and model configuration.

Related reference:
Rules for using CSV data sources
Summarizes the set of rules and limitations that apply to the use of CSV files as a
data source.

Rules for using CSV data sources
The following is the set of rules that must be followed when using a CSV
filesystem as the Operations Analytics Predictive Insights Managed data source.

Rules for CSV file naming
v The file name must begin with a table or group reference, followed by a start

time, and end in .CSV.
v The start time in the file name must be at or before the first timestamp in the

file.
v The end time is optional and can be at or after the last timestamp in the file. If

the end time in the file name is at the same time as the start of the next interval,
this end time must be after the latest timestamp in the file. For example if the
end time of 10:05 is at the start of the next interval, the latest timestamp in the
file can be 10:04:59.

v If the timezone of the file name is different to the timezone of the file content,
the timezone must be explicitly defined in at least one of either the file name or
file content timestamps. The following examples show the timezone defined in
the file name:
CPULOAD_2013-07-17-00-00EST_2013-07-17-00-15EST.csv

CPULOAD_2013-07-17-00-00+0300_2013-07-17-00-15+0300.csv

v A sample file name with 15 minute data is:
CPULOAD_2013-07-17-00-00_2013-07-17-00-15.csv

The file name defines that the file contains data having:
– Source table CPULOAD
– The first timestamp in the file is July 17 2013 at 00:00
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– The last timestamp is earlier than July 17 2013 at 00:15

Note: For more information on how to create file naming patterns, see “Example
file naming patterns” on page 18

Rules for CSV file content

If data is provided in CSV format, then the following rules and limitations apply to
those CSV files:

Column format

v Date and time must be in the same column. Ideally the timestamp will
be in UTC, or will otherwise contain the timezone information as per
Java SimpleDateFormat, http://docs.oracle.com/javase/7/docs/api/
java/text/SimpleDateFormat.html, supplying the timezone information
in the data will allow it to be adjusted for Daylight Savings Time.
If the date and time is not in the same column, you must pre-process
those files to combine those two columns, or re-export those csv files
while doing that join during the export.

v Resource names can be made from several columns (in the Mediation
Tool). One part of the resource name must be assigned to an attribute
named 'Node'. If a null or empty value is seen for the Node attribute,
that row of data is discarded. Nulls in other parts of the resource key are
not desirable, but will not lead to the data being discarded, instead, the
resource name will be made up of only the non-null parts of the key.

Characters

v Files must be in CSV format. Ensure that any text fields that contain a
comma are surrounded in quotes, for example, Supplier column
contains ’International supplies, Inc.’

v Metric values with a decimal point should not use a comma as the
decimal point, they must use a full stop character, “.”

v If a field is surrounded by double quotes, it must not otherwise contain
double quotes, for example, "International "supplies" Inc"

Time

v Files can contain data spanning any time frame, but if the file content
spans multiple intervals then the data must be time ordered. For
performance reasons the time window covered by a file should not be
longer than one day.

v The end time of the data in the file must be less than the end of the
interval as stated in the file name, it cannot be equal to the end of the
interval. For example, a 5-minute interval with start time of 10:00 and
end time of 10:05 can have a last timestamp of 10:04:59.

v Files must be delivered to the source location for the extractor before the
latency time specified for the extractor expires. The default latency is the
same period as the system.aggregation.interval, with the minimum
latency being 1 minute.

Examples of valid CSV file formats

The following example illustrates a CSV file format containing data and time
stamp in epoch format. Date and time must be in the same column.
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#timestamp,resourceName,AvgLoad,AvgPercentMemoryUsed
1361523600000,“resource1”,6,21.900673
1361523600000,“resource2”,0,45.12558
1361523600000,“resource3”,12,20.727364
1361523600000,“resource4”,5,23.801073

The following example illustrates a CSV file format where data and time stamp are
a string. Date and time must be in the same column.
#Timestamp, ResourceId,Metric_0
201304160815,ResourceId_1,0.0110
201304160815,ResourceId_2,0.0110
201304160815,ResourceId_3,0.0110

The following example illustrates a CSV file format where data and time stamp are
a string, but not at the first position. The first column shows that fields can contain
white space.
#Device,Parent Device,Sensor,Location,Time,Value
device 1 complex name,127.0.0.1,Sensor1,11/01/2014 16:35,46
device 1 complex name,127.0.0.1,Sensor1,11/01/2014 16:35,61
device 1 complex name,127.0.0.1,Sensor1,11/01/2014 16:39,46
device 1 complex name,127.0.0.1,Sensor1,11/01/2014 16:40,61
device 1 complex name,127.0.0.1,Sensor1,11/01/2014 16:40,46

The following example shows a CSV file where the data is in skinny format. In this
format, metric names are contained in rows of data underneath a header row.
Timestamp,Node,SubResource,MetricName,MetricValue
2015-04-10 04:16:13.0,server1,subresourceA,M1,7003
2015-04-10 04:16:13.0,server1,subresourceA,M2,6683
2015-04-10 04:16:13.0,server1,subresourceA,M3,1041
2015-04-10 04:16:13.0,server1,subresourceB,M1,7643

Example file naming patterns
Naming patterns use regular expressions to identify the files that form part of the
data source.

Name Pattern:

The following is an example of a naming pattern:
(.+)_(\d{4}\-\d{2}\-\d{2}\-\d{2}\-\d{2})_(\d{4}\-\d{2}\-\d{2}\-\d{2}\
-\d{2}).*\.csv

The first set of parenthesis denotes the source table name.
(.+) = CPULOAD

The second and third set of parenthesis denotes the date and time.
(\d{4}\-\d{2}\-\d{2}\-\d{2}\-\d{2}) = 2013-07-17-00-00

Example - File name pattern 1

Sample file name:
CPULoad__20130321.0015+0000__20130321.0030+0000_1363911769995.csv

The file name defines that the file contains data having:
v Source table name CPULoad.
v The first timestamp in the file is March 21 2013 at 00:15.
v The last timestamp is earlier than March 21 2013 at 00:30.
v Timezone +0000
v Name Pattern: (.+)__(\d{8}\.\d{4}\+\d{4}).*__(\d{8}\.\d{4}\+\d{4}).*.csv
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v Time format: yyyyMMdd.HHmmZ

Example - File name pattern 2

Sample file name:
ITM1_1346542223223__CPULoad__20130901.2345+0300__20130902.0000+0300.csv

The file name defines that the file contains data having a source table with the
name CPULoad.
v Name Pattern: .*__([a-zA-Z]\w*)__(\d{8}.\d{4}\+\d{4}).*__(\d{8}.\d{4}\+\

d{4}).*.csv

v Time format: yyyyMMdd.HHmmZ

Adding a database data source
When you added a data source for your project, you selected the database type.

Before you begin

Operations Analytics Predictive Insights Managed supports relational databases
that have a JDBC driver. Operations Analytics Predictive Insights Managed must
be able to read time stamp, resource key, and metrics from any database set as a
data source. The user that you employ to access the database must have
permissions to list all tables of interest.

Operations Analytics Predictive Insights Managed does not support normalized
databases (normalized tables or star schemas) currently, that is, any database that
contains foreign references for resource keys. If your database has this format, you
can create a database view, in order for Operations Analytics Predictive Insights
Managed to read the database. Contact your database Administrator for
information on how to create a database view.

About this task

When you add a database data source configuration, you must enter the details of
the database in the Connection Details tab. Note the following when you update
the Connection Details tab:
v If you are connecting to any of the databases, that are listed in the Driver

drop-down menu, apart from DB2, you must first add the database's driver to
the Mediation tool. If you are connecting to a database whose driver is not listed
in the Driver drop-down menu, you must first configure the driver's properties
and then add the driver to the Mediation tool. For more information, see Adding
Database drivers to the Mediation tool.

v Use the Time Zone to specify which time zone the data source is from. For
example, Asia/Seoul - Korea Standard Time.

v If you are creating a MySQL connection, you must set the Schema to the
database name. MySQL has no concept of schemas.

v The Password is not stored so you need to enter it when you test the connection
or when you synchronize with the data source.

v Prepared Statements are precompiled SQL statements that Operations Analytics
Predictive Insights Managed can use to query the source database. By reducing
the need to compile SQL statements, prepared statements save on CPU usage.
However, in large data warehouse environments, prepared statements can cause
a non-favorable index to be chosen, resulting in reduced disk I/O performance
and increased query times.
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Procedure
1. Update the fields within the Connection Details tab.
2. Click File > Save.
3. Check for any issues with your data source by opening the Problems tab. As

you need to complete further steps to make that data source valid, an error
message is displayed within the Problems tab. The error message disappears
when you complete the data source and model configuration.

Creating a model
The purpose of creating a model configuration is to identify from the available
data that which you want Operations Analytics Predictive Insights Managed to
analyze.

The Operations Analytics Predictive Insights Managed Mediation tool can
synchronize with the data source and display the available data. If it is a database,
you are synchronizing with, the tool shows the tables that are contained within
that database. If it is a file system data source that you are synchronizing with, the
tool shows the file names and fields within that file system. You can then pick and
choose from the available data items to create your model configuration.

Synchronizing with the data source
The first step in creating your model configuration is to discover the available
data.

Procedure
1. Select the data source within the Predictive Insights Navigator tab for which

you want to create a model configuration. The data source Connection Details
are displayed.

2. Enter the data source connection Password.
3. Select the Model Design tab.

The model design tab has two parts, the data source tree view, and the editable
properties of the selected source.

4. Right click the data source icon, which is the top level of the data source tree
view, and click Synchronize Schema. The Operations Analytics Predictive
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Insights Managed Mediation tool synchronizes with the data source and
display all available tables as a list in the Model Synchronization Preview
dialog.

5. Select the tables that you want to form part of your model.
6. Click OK.

The Model Design tab now contains the list of tables that you chose.

What to do next

You can expand each table displayed in the Model Design tab to see the set of
columns they contain. You can also view the table contents by right clicking the
table icon and selecting Show Table Content. The table contents are displayed in
the Data Extraction Preview tab.

The Data Extraction Preview is provided so you can choose the parts of the
various available tables to form your new model configuration.

Selecting data
You must select the items in each data source that you want Operations Analytics
Predictive Insights Managed to extract and analyze.

About this task

You use the Model Design tab to select the items in each data source that you
want Operations Analytics Predictive Insights Managed to extract and analyze.

Procedure
1. From the set of tables you selected and that are displayed within the Model

Design tab, drag the tables that you want to form part of your model into the
Metric Group field.

2. For each table you select, update the following properties if necessary:
a. Metric Group: When you drag a table into this field, you are prompted to

enter a name for the metric group. You can accept the default name, which
is based on the table name, or type a new name. You cannot have two
metric groups with the same name within your model.

b. Group Definition: The Timestamp and Resource Key fields are populated
with columns by default. You can right-click these fields and remove the
columns, and drag columns into these fields.

c. Metric Name You see this field only if you selected Metric names in rows
for the Data Source Format when you added the data source. The Mediation
Tool populates the field with a default column if it finds one that is suitable.
You can remove the default column by right-clicking, and drag a
replacement column.

d. Metric value You see this field only if you selected Metric names in rows
for the Data Source Format when you added the data source. The Mediation
Tool populates the field with a default column if it finds one that is suitable.
You can remove the default column by right-clicking, and drag a
replacement column.

e. Attributes: The Attributes field must contain the columns listed in the
Group Definition>Resource Key field. Otherwise, an error is displayed in
the Problems tab. You can rename attributes, but one attribute must be
named Node. You can also add Attributes from a table in the data source.
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To add an attribute, drag a column from the table to the Attributes field or
right-click on a column in the table and select Add Attribute.

Note: Each attribute present in the model can be added to the alarm
information displayed in the Operations Analytics Predictive Insights
Managed User Interface. By default, the Node attribute is shown in the
alarm information.
You can set the resource by which alarm consolidation occurs.
Consolidation by node is a means of logically grouping alarms under one
alarm based on a shared resource. To set node consolidation within your
metric group, you must add the resource by which you want to consolidate
to the Attributes tab and set the Attribute Name to Node. If multiple
anomalies are generated for the same resource in a given interval,
consolidation by that resource means that these anomalies are nested under
one parent alarm in the Active Event List.

f. Metrics: The set of metrics you want within your model. When you add the
metric group, the Metrics field is populated with a default set of metrics.
The process used to create the default set of metrics depends on the format
of the data source.
v If you selected Metric names in column headers for the Data Source

Format, the default set of metrics is taken from the metric names in the
column headers. You can drag further metrics from a table in the data
source into the Metrics field.

v If you selected Metric names in rows for the Data Source Format, the
Mediation tool queries the metric name column in the first 1,000 rows of
data and adds each unique metric name to the Metrics field. If the query
finds a colon in a metric name, the Mediation Tool displays an error
stating that a metric name is invalid because it contains a colon, which is
the default data source delimiter. You must change the default data source
delimiter to one or more characters that is not in any metric name. To
change the default data source delimiter, right click the data source icon,
which is the top level of the data source tree view, and click Set Data
Source Delimeter.

If the data source has metric names that are not found by the query within
the first 1,000 rows of data, you must manually add the metric names to the
Metrics field. To manually add the metric names, do either of the following:
v To add metrics individually, choose the Add metric icon . Type a metric

name that matches exactly the metric name in the data source.
v To add multiple metrics simultaneously, first add the metric names,

delimited with carriage returns, to a .TXT or .CSV file. Then, click the
Add metrics from file icon 

 
and select the file. Any metric name in the

file that exists in the Metrics field is not added again.
To remove a metric from the Metrics field, right-click the metric and choose
Remove Metric.

3. Click File > Save.

What to do next
1. To confirm that the model contains all the elements that you require, click the

Data Extraction Preview tab. The Data Extraction Preview tab shows a sample
of the data that will be extracted based on the model you created. All
timestamps in the extraction preview are shown in UTC time. When it begins
to extract data, Operations Analytics Predictive Insights Managed converts all
source data to UTC.
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If the value of a column in the model's Resource key field is blank in any of the
sample rows of data retrieved from the data source, the following message is
displayed:
Data extraction for {dasourceName}.{table_or_metric_grp} failed

Data for a row that has a blank resource key column is omitted from the
preview but you can proceed with the validation and deployment of the model.

2. Validate the model design by checking for the presence of errors, which are
listed in the Problems tab.

3. For file data sources:
a. Check the input directory, which is contained within the directory as

specified by the File Path parameter, for the presence of any *.bad files.
The *.bad files show which rows of the source file will not be accepted by
the extractor, for example, text present in a number field.

b. Analyze the *.bad files to decide whether the metric group definition needs
to be adjusted.

c. Remove the *.bad files if you adjusted the model and run the Data
Extraction Preview again.

Verifying and updating the timestamp
For each metric group, the Operations Analytics Predictive Insights Managed
Mediation tool selects the field that it considers to be the best match for the time
stamp. You must ensure that the correct field was selected and its properties
correctly set.

You can replace the timestamp selected for a metric group in the Timestamp field
within the Group Definition section of the Model Design tab. To replace the
timestamp, right click on the existing metric in the Timestamp field and select
Remove Timestamp Key. Then, drag a new metric into the field.

You can verify that the timestamp is configured correctly and, if necessary, update
the properties of the timestamp in the Model Properties tab. To verify that a
metric group timestamp is configured correctly, perform the following steps:
1. Check that the correct metric is in the Timestamp field within the Group

Definition section of the Model Design tab.
2. Open the Model Properties tab and in the Model Objects pane select the

drop-down for the relevant metric group. The Timestamp is listed as the first
item under the metric group.

3. Click the Timestamp and ensure that the Data Type and Time Format are set
correctly.

4. Run a preview of the extraction for the metric group to ensure it does not fail
with any time format errors.

Setting the timestamp in epoch format

To specify that a time stamp is an epoch time stamp:
1. Open the Model Properties tab.
2. Select the Timestamp option underneath the relevant metric group.
3. In the Model Object Properties set the Data Type to be either Integer or

Number based on:
v Integer is a 10 digit number representing time in seconds since epoch.
v Number is a 13 digit number representing time in milliseconds since epoch.
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4. Delete the string that is contained in the Time Format field.

Creating filters
Filters control the data that is extracted from a data source by Operations Analytics
Predictive Insights Managed. When you create a filter, only data that matches the
filter criteria is extracted.

Procedure
1. Select the data source within the Operations Analytics Predictive Insights

Managed Navigator tab for which you want to add a filter.
2. Select the Model Properties tab.
3. Under Model Objects, expand Model and a metric group name. Under the

metric group name, you see the following model objects: time stamp, resource
keys, attributes, and metrics. You can create filters for the following objects:
v Resource key: accepts only regular expressions as a filter string.
v Attributes: accepts only alphanumeric strings as a filter string.

4. To create a filter, click the resource key or attribute in the model tree view and
enter the filter into the Filter expression field that is listed under the Model
Object Properties. A filter expressions can contain any character but
double-quotes (" ") in an expression has no effect on what is filtered.
v When you create a filter expression for a resource key or attribute, the filter

is added to the list of filters available under Model Objects->Filters.
Similarly, if you update a filter expression under a resource key or attribute,
a new filter is added under Model Objects->Filters. For example, if you
update a filter expression for an attribute from ABC to ABCD, you see filters
for both expressions. You can copy a filter from Model Objects->Filters and
apply it to an attribute or resource key by completing the following steps:
a. Under Model Objects->Filters, click the filter that you want to copy.
b. Under Model Object Properties, select the value in the Filter expression

field.
c. Right click and choose Copy.
d. Under Model Objects, navigate to the object to which you want to apply

a filter.
e. Under Model Object Properties, select the Filter expression field.
f. Right click and click Paste to paste the expression into the field.

Note: If you select a filter expression under Model Objects->Filters and
update the Filter expression field, the filter expression is updated in any
resource key or attributes to which the filter applies.

Example

ResourceKey filtering
Any java regular expression can be used. If ResourceKey does not match
the regex, it is skipped.

Attributes filtering

The Attributes field can contain a comma separated list of alphanumeric
characters (that is a-zA-Z_0-9 and a comma to separate each filter for each
attribute you want to match).
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The generated SQL becomes a clause such as: where xxx like
’%expression%’ or where (xxx like ’%expression1%’ or xxx like
’%expression2%’...)

Unpegging
The unpegging of metrics results in each received metric value being saved so that
it can be compared to the next value. By comparing the current value with the
previous value the extractor is able to establish the delta for that metric.

The delta is the difference between the value currently being extracted and the
previous value. The delta is often more useful to the algorithm than the actual
value.

Unpegging of metrics is implemented using the Mediation tool.

To unpeg a metric:
1. Select the data source within the Predictive Insights Navigator tab for which

you want to unpeg metrics.
The Connection Details tab is displayed.

2. Select the Model Properties tab.
The tab displays a tree view of the available Model Objects, which are made
up of the time stamp, resource keys, attributes, and metrics of your logical
model.

3. Select the metric you wish to unpeg.
4. In the Model Object Properties pane, click the Metric Type field and select

Accumulation from the drop-down menu.

Validating a model
It is important to validate your model, as the Operations Analytics Predictive
Insights Managed Mediation tool can not deploy a model that has errors or is
inconsistent with the database.

Procedure
1. Right click the model you want to validate within the Predictive Insights

Navigator tab, and click Open.
2. If your project is already open, ensure that it is saved, by clicking Save.
3. Open the Problems tab. If the Problems tab is not visible, click Window >

Show View > Problems.
The Problems tab displays all issues that it can see with your tool based on the
model you saved.
The Operations Analytics Predictive Insights Managed Mediation tool looks for
errors in the model. Errors can be inconsistencies between the new model and
the source model, created when you synchronized with the data source.

4. Resolve the problems that are listed.
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Importing a model
You can import an existing model file into your project.

About this task

Instructions on how to import a model file into your project within the Operations
Analytics Predictive Insights Managed Mediation tool.

Procedure
1. Select your project and then click File > Import. The Import dialog opens.
2. Click Predictive Insights > Predictive Insights model.
3. Click Next.
4. Click Browse next to the Data Source File field and change to the directory

that contains the model you would like to import.
5. Select the check box corresponding to the model or models that you would like

to import into your project.
6. Click Finish.

Exporting a model
You can reuse a model within another project.

Procedure
1. To export all models within project, you right click the project and then click

Export. To export only a single model, right click that model and click Export.
2. Click General > File System.
3. Click Next

4. Click Browse next to the To directory field and change to the directory to
which you would like to export the model. This allows you to select the project
folder to which you would like to export.

5. Select the check box corresponding to the model or models that you would like
to export.

6. Click Finish.

Model configuration scenarios
The model configuration scenarios section illustrates how to configure an
Operations Analytics Predictive Insights Managed model for specific data source
scenarios.

CSV file names and data are for different time zones
The following examples show how to configure Operations Analytics Predictive
Insights Managed when the time stamps in the file names and data represent
different time zones.

Example 1: Time zone shown in CSV file names but not in data

In this example:
v the time stamp for the CSV source files is in EST as shown in the file name
v the time stamps for the data within the file are known to be in GMT but the

time zone is not shown.
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File name:

CPULOAD_2013-07-17-00-00EST_2013-07-17-00-15EST.csv

Data:
EndTime,Resource,In_TotalBytes,Out_TotalBytes
2013-07-17-05-00,"ethernet-csv785.tut.com_GigabitEtherenet2", 3263768830,9545496800

Configuration in Operations Analytics Predictive Insights Managed:

To configure Operations Analytics Predictive Insights Managed for the time stamps
used in the example:

When you add the file system data source in the Mediation tool, set the following
fields:
v In the Name Pattern field, enter : ([a-zA-Z]\w*)_(\d{4}-\d{2}-\d{2}-\d{2}-\

d{2}\w{3})_(\d{4}-\d{2}-\d{2}-\d{2}-\d{2}\w{3}).*\.csv

v In the Time Format field, enter: yyyy-MM-dd-HH-mmz. The z at the end of the field
indicates that the last 3 characters of the file name are a time zone identifier

v In the Time Zone field, set the time zone to Europe/London - Greenwich Mean
Time. When the time stamps in the file name and data represent different time
zones and the time zone is specified in only one of the time stamps, you set this
field to the time zone that is not specified in the time stamp. In this example, the
time stamps in the data are in GMT but the time zone is not specified in the
time stamp, so you set the timezone to GMT.

Example 2: Time zone shown in data but not in CSV file names

In this example,
v the time stamp in the file name is known to represent EST but the time zone

information is not shown in the file name.
v the time stamp in the data is in GMT and time zone is included in the time

stamp

File name:

CPULOAD_2015-07-17-00-00_2015-07-17-00-15.csv

Data:
EndTime,Resource,In_TotalBytes,Out_TotalBytes
2013-07-17-05-00+0000,"ethernet-csv785.tut.com_GigabitEtherenet2",3263768830,9545496800

Configuration in Operations Analytics Predictive Insights Managed:

To configure Operations Analytics Predictive Insights Managed for this example,
do the following:

In the Mediation tool's File System Details tab, do the following:
v In the Name Pattern field, enter: ([a-zA-Z]\w*)_(\d{4}-\d{2}-\d{2}-\d{2}-\

d{2})_(\d{4}-\d{2}-\d{2}-\d{2}-\d{2}).*\.csv

v In the Time Format field, enter: yyyy-MM-dd-HH-mm.
v In the Time Zone field, set the time zone to America/New_York - Eastern

Standard Time. When the time stamps in the file name and data represent
different time zones and the time zone is specified in only one of the time
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stamps, you set this field to the time zone that is not specified in the time stamp.
In this example, the time zone in the file name is not specified but is known to
represent EST, so you set the timezone to America/New_York - Eastern Standard
Time.

In the Mediation tool's Model Properties tab, do the following:
v In the Model Objects pane, expand the metric group and click Timestamp.
v In the Model Object Properties pane, enter the following value in the Time

Format field: yyyy-MM-dd-HH-mmZ. The Z at the end of the field indicates that the
time stamps in the data end with the time zone specified in the RFC 822 4-digit
format.

Example 3: Time zone shown in both the CSV file name and data

In this example,
v the time stamp in the file name shows the EST time zone.
v the time stamp in the data shows the GMT time zone

File name:

CPULOAD_2013-07-17-00-00EST_2013-07-17-00-15EST.csv

Data:
EndTime,Resource,In_TotalBytes,Out_TotalBytes
2013-07-17-05-00GMT,"ethernet-csv785.tut.com_GigabitEtherenet2",3263768830,9545496800

Configuration in Operations Analytics Predictive Insights Managed:

To configure Operations Analytics Predictive Insights Managed for this example,
do the following:

In the Mediation tool's File System Details tab, do the following:
v In the Name Pattern field, enter: ([a-zA-Z]\w*)_(\d{4}-\d{2}-\d{2}-\d{2}-\

d{2}\w{3})_(\d{4}-\d{2}-\d{2}-\d{2}-\d{2}\w{3}).*\.csv

v In the Time Format, field enter: yyyy-MM-dd-HH-mmz. The z at the end of the field
indicates that the last 3 characters of the file name are a time zone identifier

v In the Time Zone field, set the time zone to America/New_York - Eastern
Standard Time. When different time zones are explicitly shown in the file name
and data, set the time zone to that shown in the file name.

In the Mediation tool's Model Properties tab, do the following:
v In the Model Objects pane, expand the metric group and click Timestamp.
v In the Model Object Properties pane, enter the following value in the Time

Format field: yyyy-MM-dd-HH-mmz. The z at the end of the field indicates that the
time stamps in the data end with the time zone specified in the General time
zone format.
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CSV file names and data have no time zone identifier
The following examples show how to configure Operations Analytics Predictive
Insights Managed when there is no time zone identifier in the time stamps in the
CSV file names or the data in the files.

Example: CSV file names and data have no time zone identifier

If there is no time zone identifier in the time stamps in the CSV file name or the
data within the files, the time stamps in both the file names and the data must be
for the same time zone.

File name:

CPULOAD_2013-07-17-00-00.csv

Data:
EndTime,Resource,In_TotalBytes,Out_TotalBytes
2013-07-17-05-00,"ethernet-csv785.tut.com_GigabitEtherenet2", 3263768830,9545496800

Configuration in Operations Analytics Predictive Insights Managed:

To configure Operations Analytics Predictive Insights Managed for the time stamps
used in the example:

When you add the file system data source in the Mediation tool, set the following
fields:
v In the Name Pattern field, enter : ([a-zA-Z]\w*)_(\d{4}-\d{2}-\d{2}-\d{2}-\

d{2}).*\.csv

v In the Time Format field, enter: yyyy-MM-dd-HH-mm.
v In the Time Zone field, select the appropriate time zone that represents both the

file names and the data.

In the Mediation tool's Model Properties tab, do the following:
v In the Model Objects pane, expand the metric group and click Timestamp.
v In the Model Object Properties pane, enter the following value in the Time

Format field: yyyy-MM-dd-HH-mm.

CSV files are for multiple time zones
This topic describes how to configure Operations Analytics Predictive Insights
Managed when a CSV data source has time stamps for multiple time zones in the
CSV file names or the data within the files.

If there are multiple time zones in CSV file names, or the data within CSV files,
you must do the following:
v Group the CSV files by time zone in separate directories on the Analytics server
v Add a separate file system data source for each directory in the Mediation tool
v Create a separate model for each data source in the Mediation tool
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Deploying a model
You must deploy the model to the database so it is usable by Operations Analytics
Predictive Insights Managed.

Before you begin

A model is defined by the set of defined data sources that you select to deploy.
This can be all of the data sources under a project, or a subset of those data
sources. Each data source has it's own .pamodel file in the workspace and these
will be automatically combined when deployed together. You can edit a model
after you deploy it. When you edit a model, you can only add, remove, or rename
metric groups. When you redeploy the updated model, the previous version of the
model is overwritten.

You must deploy each model that you create to a topic. Topics allow you to
segment your data in ways that are relevant to your business. For example, you
can use a topic to group data that originates from a specific service, application, or
geography. The anomalies generated based on your data can then be grouped and
displayed by topic.

For information about creating a new topic see Creating a topic in the Configuring
and Administering Guide.

When you deploy a model to a topic, the previous version of the topic is
overwritten. Therefore, if you wish to deploy a model to a topic that contains other
models, you must select all models for the specific topic, in the Mediation Tool,
and deploy them together. If you are redeploying one or more models to a topic
that is already running, you must first stop the topic using the stop command. In
addition, if the topic has already consumed data, you need to run data extraction
and start model training again after you redeploy the model(s).

Note: If there is only a single topic in your system, the model is deployed to that
topic automatically.

Procedure
1. Within the Predictive Insights Navigator pane, select the model or set of

models that you want to deploy. You can select multiple models only if all of
those models exists as part of the one project.

2. Click Predictive Insights > Deploy Model.
3. The Predictive Insights Model Deployment dialog opens, in which you enter

the Operations Analytics Predictive Insights Managed database connection
details and password.

Note: The database credentials are automatically populated with the user
credentials of scadmin. Make sure that you update the user credentials with
the details of your Operations Analytics Predictive Insights Managed database
user.

4. Select the Calculate KPI Count check box to generate an estimate of the
number of KPIs for the model you are deploying. The KPI count is shown as
you deploy the model.

Note: The Mediation Tool calculates the KPI Count from a sample of the
source data. By default, the sample is taken from data created between 00:00
and 01:00 and 12:00 and 13:00. When you are using a file system data source,
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ensure that this sample is representative of the complete data set by having at
least one full day of data available to the Mediation Tool. If the Mediation
Tool is running on a separate server to the Analytics component, you must
copy the sample data to the Mediation Tool server.

5. Click OK.
6. You are prompted to enter the data source connection password for each

database data source. Enter the password for each database data source and
click OK.

Note: File system data sources do not request a password.
The Operations Analytics Predictive Insights Managed Mediation tool now
validates your model against the actual data source.

Note: An error occurs if you choose to deploy your model without first
ensuring you have access through the firewall to the server that contains the
database.

7. If you are alerted that there are errors in your model:
a. Fix any validation errors that are displayed in the problems tab.
b. After fixing errors, deploy your model or models again by selecting them

within the Predictive Insights Navigator pane and clicking Predictive
Insights > Deploy Model.

8. If you have more than one topic available, the Topic Selection dialog opens.
Select the topic with which you want to associate your new model. If you
have only one topic available, this topic is selected by default.

Note: You can only deploy separate data sources to the same topic if those
sources overlap in time. For example, if data source 1 is a CSV datasource
with data from July to September and Datasource 2 is a CSV datasource with
data from October to December then you must not deploy these data sources
to the same topic.

9. Click OK.
10. The Mediation Tool calculates and displays the KPI count. If the KPI count

matches the number of KPIs you planned to deploy in the model, choose Yes
to complete the deployment. Otherwise, choose No and modify your model to
add or remove metrics, as required.

Creating a topic
You must deploy each model that you create to a topic. A default topic is created
as part of the installation of the Analytics component. You can create additional
topics to segregate data analysis and presentation.

About this task

Topics allow you to segment your data in ways that are relevant to your business.
For example, you can create a topic and use it to group data that originates from a
specific service, application, or geography. The anomalies generated based on your
data can then be grouped and displayed by topic. Data in different topics are
analyzed independently of each other and no analysis takes place across topics.
When you deploy a new model, you are asked to choose the topic to which the
new model belongs.

Note: For file based data sources, do not set up multiple topics that point to the
same source location.
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Procedure
1. Log on to the Operations Analytics Predictive Insights Managed Analytics

server as the administrative user, typically scadmin, and navigate to
$PI_HOME/bin.

Note: The $PI_HOME environment variable is set automatically when the user
logs in. However, if your user's shell has been running since before the
installation, you might need to exit and log in again.

2. Run the create_topic command for each topic you wish to create.
The create_topic command is one of the available commands within the admin
CLI application:
./admin.sh create_topic <topic name> <description>

Where:
v <topic name>: Is the name of the new topic. The topic name must be one

word between 3 and 10 characters long. It can contain alphanumeric
characters and the underscore character

v <description>: The topic description. The description should be enclosed in
double quotes if it contains spaces.

For example:
./admin.sh create_topic network "Topic for network data"

What to do next

If the topic is no longer being used it can be deleted using the delete_topic
command.
Related reference:
“create_topic” on page 86
The create_topic CLI command.
“delete_topic” on page 86
The delete_topic CLI command.
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Chapter 3. Configuring security

Configuring security for Dashboard Application Services Hub

You need to perform steps to configure additional security when Operations
Analytics Predictive Insights Managed is deployed with Dashboard Application
Services Hub.

Securing sensitive cookies

About this task

Procedure
1. Enter the URL of the WebSphere administrative console: https://

<hostname>:16316/ibm/console.
where <hostname> is the name or IP address of the Dashboard Application
Services Hub server.

2. On the login screen, enter your username and password as configured during
installation. The default username set at installation is smadmin.

3. On the navigation panel, click Applications->Application Types->WebSphere
enterprise applications.

4. In the Enterprise Applications table, click isc.
5. Under Web Module properties, click Session Management.
6. Under General Properties, ensure that Enable cookies is checked.
7. Click the Enable cookies link.
8. Click the Restrict cookies to HTTPS sessions check box. Do not click the Set

session cookies to HTTPOnly ... checkbox as to do so will prevent access to
the Active Event List.

9. Click OK to close the Cookies page and OK again to close the Session
management page.

10. To save the changes, under Messages, click Save.
11. Restart Dashboard Application Services Hub.

Increasing transport layer security

About this task

Procedure
1. Enter the URL of the WebSphere administrative console: https://

<hostname>:16316/ibm/console.
where <hostname> is the name or IP address of the Dashboard Application
Services Hub server.

2. On the navigation panel, click Security->SSL certificate and key management.
3. Under Related items, click ssl configurations.
4. On the login screen, enter your username and password as configured during

installation. The default username set at installation is smadmin.
5. In the table, click NodeDefaultSSLSettings.
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6. Under Additional Properties click Quality of protection (QOP) settings.
7. In the Protocol drop down, select TLS.
8. To save the changes, under Messages, click Save.
9. Restart Dashboard Application Services Hub.

Disable auto-complete on the Dashboard Application Services
Hub login panel

How to disable auto-complete on the Dashboard Application Services Hub login
panel.

About this task

Procedure
1. As the user that installed Dashboard Application Services Hub, log in to the

server.
2. Change to the <installdir>/config/cells/ /JazzSMNode01Cell/applications/

isc.ear/deployments/isc/isclite.war/WEB-INF directory.
Where <installdir> is the directory where Dashboard Application Services Hub
is installed.

3. Edit the customizationProperties.xml file.
4. Set the value of the LOGIN.CACHEPASSWORD property to false.
5. Save the file.
6. Restart Dashboard Application Services Hub.

Configuring security for Tivoli Integrated Portal

You need to perform steps to configure additional security when Operations
Analytics Predictive Insights Managed is deployed with Tivoli Integrated Portal.

Securing sensitive cookies

About this task

Procedure
1. Enter the URL of the WebSphere administrative console: https://

<hostname>:16316/ibm/console.
where <hostname> is the name or IP address of the Dashboard Application
Services Hub server.

2. On the login screen, enter your username and password as configured during
installation. The default username set at installation is smadmin.

3. On the navigation panel, click Applications->Application Types->WebSphere
enterprise applications.

4. In the Enterprise Applications table, click isc.
5. Under Web Module properties, click Session Management.
6. Under General Properties, ensure that Enable cookies is checked.
7. Click the Enable cookies link.
8. Click the Restrict cookies to HTTPS sessions check box. Do not click the Set

session cookies to HTTPOnly ... checkbox as to do so will prevent access to
the Active Event List.
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9. Click OK to close the Cookies page and OK again to close the Session
management page.

10. To save the changes, under Messages, click Save.
11. Restart Dashboard Application Services Hub.

Increasing transport layer security

About this task

Procedure
1. Enter the URL of the WebSphere administrative console: https://

<hostname>:16316/ibm/console.
where <hostname> is the name or IP address of the Tivoli Intetrated Portal
server.

2. On the navigation panel, click Security->SSL certificate and key management.
3. Under Related items, click ssl configurations.
4. On the login screen, enter your username and password as configured during

installation. The default username set at installation is smadmin.
5. In the table, click NodeDefaultSSLSettings.
6. Under Additional Properties click Quality of protection (QOP) settings.
7. In the Protocol drop down, select TLS.
8. To save the changes, under Messages, click Save.
9. Restart Tivoli Integrated Portal.

Configuring certificates
Self-signed certificates are automatically generated during the installation of
Operations Analytics Predictive Insights Managed. In a production environment, it
is recommended that your replace the self-signed certificates with certificates
signed by a third party certificate authority. Follow these steps to install certificates
on the Operations Analytics Predictive Insights Managed servers.

Adding a signed certificate to the User Interface Server
How to add a signed certificate to the Operations Analytics Predictive Insights
Managed User Interface Server.

Procedure
1. Go to the <installdir>/UI/wlp/usr/servers/piserver/resources/security

directory:
cd <installdir>/UI/wlp/usr/servers/piserver/resources/security

Where <installdir> is the directory where Operations Analytics Predictive
Insights Managed is installed. The default installation directory is
/opt/IBM/scanalytics.

2. Enter the following command to make a backup copy of the key.jks keystore
file:
cp key.jks key.jks.orig

3. Enter the following command to generate a certificate request based on the
default self-signed certificate:
<installdir>/UI/ibm-java-x86_64-70/bin/keytool -certreq -alias default -file certreq.pem -keystore key.jks -storepass emrjtn56rtjg
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4. Obtain a signed certificate from a third party certificate authority. Normally, the
certificate authority provides the signed certificate along with a root and
intermediate certificate.

5. If the certificate authority provided root and intermediate certificates, enter the
following commands in the order shown to import the certificates:
<installdir>/UI/ibm-java-x86_64-70/bin/keytool -importcert

-alias inter -file <intermediate file> -keystore key.jks -storepass emrjtn56rtjg

<installdir>/UI/ibm-java-x86_64-70/bin/keytool -importcert
-alias root -file <root file> -keystore key.jks -storepass emrjtn56rtjg

<installdir>/UI/ibm-java-x86_64-70/bin/keytool -importcert
-alias default -file <signed cert file> -keystore key.jks -storepass emrjtn56rtjg

6. If the certificate authority did not provide root and intermediate certificates,
enter the following command to import the chain along with the certificate:
<installdir>/UI/ibm-java-x86_64-70/bin/keytool –importcert -alias default -file <signed cert file> -trustcacerts
-keystore key.jks -storepass emrjtn56rtjg

Adding a signed certificate to the Dashboard Application
Services Hub server

To add a signed certificate to the Dashboard Application Services Hub server, see
the information at the following links:
v http://www-01.ibm.com/support/docview.wss?uid=swg21654278
v http://www.ibm.com/developerworks/websphere/techjournal/1210_lansche/

1210_lansche.html

Configuring LDAP authentication

Before you configure Operations Analytics Predictive Insights Managed to use
LDAP authentication, do the following:
v Verify that the User Interface functions correctly in Dashboard Application

Services Hub
v Use groups to map roles so that you only need to move users in to or out of

groups to grant or revoke privileges
v If you use https authentication for your LDAP directory, use the keytool

-importcert command to import the LDAP server certificate into the liberty
trust store. For more information on how to use the command, see “Adding a
signed certificate to the User Interface Server” on page 35. When importing the
certificate, use an alias other than default to identify the LDAP server certificate
in the trust store.

Configuring the Operations Analytics Predictive Insights
Managed UI server to use LDAP authentication

This section describes how to configure LDAP authentication for the Liberty
container that is installed with the Operations Analytics Predictive Insights
Managed UI server.

Configuring the LDAP User Registry
How to configure the LDAP user registry.
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About this task

In this procedure, <installdir> is the directory where Operations Analytics -
Predictive Insights is installed. The default installation directory is
/opt/IBM/scanalytics.

Procedure
1. Log in to the server where the Operations Analytics Predictive Insights

Managed UI component is installed.
2. Go to the <installdir>/UI/wlp/usr/servers/piserver directory.
3. Create a new file called ldapRegistry.xml and add the appropriate content to

the file for the LDAP server that you are using:
If you are using a Tivoli Directory server, add the following:
<server>
<ldapRegistry id="ldap"
realm="defaultWIMFileBasedRealm" baseDN="ou=people,ou=internal,O=IBM,C=US"
host="ldap1.ibm.com" port="389" ignoreCase="true"
bindDN="cn=NetcoolReadOnly,cn=ReadOnlyUsers,O=IBM,C=US" bindPassword="***"
ldapType="IBM Tivoli Directory Server" sslEnabled="false" ><idsFilters
userFilter="(&amp;(uid=%v)(objectclass=ePerson))"
groupFilter="(&amp;(cn=%v)(|(objectclass=groupOfNames)(objectclass=groupOfUniqueNames)
objectclass=groupOfURLs)))" userIdMap="*:uid"
groupIdMap="*:cn"
groupMemberIdMap="mycompany-allGroups:member;mycompany-allGroups:uniqueMember;
groupOfNames:member;groupOfUniqueNames:uniqueMember"></idsFilters></ldapRegistry>
</server>

If you are using a Microsoft Active Directory server, add the following:
<server>
<ldapRegistry id="ldap"
realm="defaultWIMFileBasedRealm" host="DC1.ibm.com" port="389"
baseDN="CN=Users,DC=webguil3,DC=ldap,DC=com"
bindDN="cn=manitou,CN=Users,DC=webguil3,DC=ldap,DC=com" bindPassword="*****"
ldapType="Microsoft Active Directory" sslEnabled="false" ><activedFilters
userFilter="(&amp;(sAMAccountName=%v)(objectcategory=user))"groupFilter="(&amp;(cn=%v)(objectcategory=group))"
userIdMap="user:sAMAccountName"groupIdMap="*:cn" groupMemberIdMap="memberOf:member"></activedFilters>
</ldapRegistry></server>

4. Edit the values in the text you add to the ldapRegistry.xml file to match your
LDAP settings. Pay particular attention to the following:
v The realm specified in the ldapRegistry.xml file must match the realm

name specified in the WebSphere Administrative Console. If they do not
match, single-sign-on will not work. The default realm is:
defaultWIMFileBasedRealm

v Ensure that the values in the userIdMap and groupIdMap fields are correct.
Otherwise, log in will fail.

v Ensure that the ldapRegistry tag is on a single continuous line. Otherwise,
the liberty server may fail parsing it.

Also, ensure that the values you specify match the settings for Dashboard
Application Services Hub. To check the settings in Dashboard Application
Services Hub
a. Go the following URL to launch the Webshere Administrative console:

https://<hostname>:16316/ibm/console

b. Log in as the scadmin user.
c. Click Security > Global Security.
d. Click Configure.
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e. Locate the LDAP repository in the table and click on Base Entry link to
verify the base DN.

f. Click on the Repository Identifier and verify the bindDN, host and port.
5. Make a backup copy of the <installdir>/UI/wlp/usr/servers/piserver/

server.xml file.
6. Edit the <installdir>/UI/wlp/usr/servers/piserver/server.xml file.
7. Comment out or remove the following lines:

<feature>usr:omnibusUserRegistry-1.0.0</feature>
<include optional="true" location="${server.config.dir}/omnibusConfig.xml"/>

8. Add the following feature as a sub element of the <featureManager> tag:
<feature>ldapRegistry-3.0</feature>

After you add the feature, this section of the file should look as follows:
<!-- Enable features -->
<featureManager>

<feature>jsp-2.2</feature>
<feature>jaxrs-1.1</feature>
<feature>servlet-3.0</feature>
<feature>appSecurity-2.0</feature>
<feature>jndi-1.0</feature>
<feature>jdbc-4.0</feature>
<!--<feature>usr:omnibusUserRegistry-1.0.0</feature> -->
<feature>ldapRegistry-3.0</feature>

</featureManager>

9. Locate and Remove the comment from the following line:
<!-- <include optional="true" location="${server.config.dir}/ldapRegistry.xml"/> -->

After you remove the comment, the line looks as follows:
<include optional="true" location="${server.config.dir}/ldapRegistry.xml"/>

10. Save the file.
11. Enter the following command to restart the Operations Analytics Predictive

Insights Managed UI server:
<installdir>/UI/bin/pi.sh –restart

Granting LDAP users and groups access to Operations Analytics
Predictive Insights Managed
To grant users in the LDAP directory access to Operations Analytics Predictive
Insights Managed, it is recommended that you assign Operations Analytics
Predictive Insights Managed roles to LDAP groups and add LDAP users to the
groups.

About this task

Note:

If you create groups called predictiveInsightsUsers and
predictiveInsightsAdmins in your LDAP directory, roles are automatically
assigned to these groups and you do not need to complete the following
procedure.

Procedure
1. Log in to the Operations Analytics Predictive Insights Managed server.
2. Go to the <installdir>/UI/bin directory.
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Where <installdir> is the directory where Operations Analytics Predictive
Insights Managed is installed. The default installation directory is
/opt/IBM/scanalytics.

3. Run the following command to grant an LDAP user or group access to
Operations Analytics Predictive Insights Managed:
addAccess.sh <user | group> <user or group name> [admin]

For example, to grant administrator access to a group called PI_admins, enter
the following:
addAccess.sh group PI_admins admin

Verifying the LDAP configuration
How to verify that the LDAP authentication and authorization is configured
correctly for the Operations Analytics Predictive Insights Managed User Inteface
server.

About this task

Procedure
1. Go to the following URL: https://<hostname>:9998/predictiveinsights/jsp/

wlp/wlpAnomalySearch.jsp

where <hostname> is the name or IP address of the server on which the
Operations Analytics Predictive Insights ManagedUser Interface component is
installed.

2. On the login screen, enter the username and password of an LDAP user. If you
log in successfully, the Anomaly Search screen is displayed. If the log in fails:
v Confirm that the information you added to the ldapRegistry.xml file is

correct.
v If you receive an authorization error, ensure that the procedure to grant

LDAP users access to Operations Analytics Predictive Insights Managed was
completed correctly.

3. After you log in successfully, test that the single sign-on is correct::
a. Close all open instances of your browser.
b. Launch Dashboard Application Services Hub.
c. On the log in screen, enter the username and password of an LDAP user.
d. Verify that the snowflake icon, , is visible on the Dashboard Application

Services Hub menu. If it is not visible, then there is either a single sign-on
issue or an issue with the console integration

e. If the snowflake icon is not visible, open a new browser tab and go to the
following URL:https://<hostname>:9998/predictiveinsights/jsp/wlp/
wlpAnomalySearch.jsp

f. If you are prompted for a user name or password or receive an
authentication error, verify that the realm entered in ldapRegistry.xml
matches the realm name in the WebSphere Administrative console, under
Federated Repositories.

Note:
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Configuring Omnibus Web GUI authentication against an
LDAP directory

You can configure the Web GUI to authenticate users and groups against an LDAP
directory. The configuration steps involve adding the LDAP directory to the Virtual
Member Manager (VMM) realm and configuring VMM to write new users to the
LDAP directory. You then assign Web GUI roles to the LDAP users and
synchronize those users with the ObjectServer. The synchronization enables the
users to write to the ObjectServer, so that they can use Web GUI functions that
require ObjectServer write-permissions.

Before you begin
v Familiarize yourself with the concept of the VMM realm. See Web GUI user

authentication in the Tivoli Omnibus Knowledge Center.
v Ensure that the LDAP directory is running and that it can be accessed from the

Web GUI host computer.
v If the previous user repository was the default file-based repository, remove any

default users that were created when the file-based repository was added. You
need to remove these users to avoid duplicate users across repositories in the
realm.

v Obtain the following information about the LDAP directory. You need this
information to configure the LDAP directory in the realm.
– Host name and port number of the primary server that hosts the LDAP

directory and the backup server, if applicable. The host names must contain
no spaces.

– Type and version of LDAP directory that is used, for example IBM Tivoli
Directory Server V6.2, or Microsoft Active Directory.

– User ID and password that are used to bind to the LDAP server. This user ID
must be unique. For example, cn=root. Important: To create users and groups
through the Web GUI, the LDAP bind ID must have the appropriate
permissions in the LDAP directory. The bind ID must contain no spaces.

– Subtree of the LDAP directory that you want to be used for authenticating
users.

Sample LDAP data

The following configuration tasks use sample data from a subtree in an LDAP
directory. When you perform the configuration tasks, replace the sample data with
your own.

The LDAP directory is identified as TIVIDS. TIVIDS contains the subtree
ou=NetworkManagement,dc=myco=dc=com, which contains the users and groups
that will be authenticated by the Web GUI. In this subtree, the LDAP objects are
defined as follows:
v The user prefix is uid
v The user suffix is cn=users
v The group prefix is cn
v The group suffix is cn=groups

In the subtree, the administrator user with the user name Administr8or is therefore
defined as uid=Administr8or,cn=users,ou=NetworkManagement,dc=myco,dc=com.
The administrator user group with the name AdminGroup is defined as
cn=AdminGroup,cn=groups,ou=NetworkManagement,dc=myco,dc=com.
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Adding the LDAP directory to the realm
To authenticate the users from an LDAP directory, the Web GUI needs to read the
LDAP user data. To achieve this, add the LDAP directory to the Virtual Member
Manager (VMM) realm as a repository.

Before you begin

You need the following information to configure the LDAP directory in the realm:
v The host name and port number of the primary server that hosts the LDAP

directory and the backup server, if applicable. The host names must contain no
spaces.

v Type and version of LDAP directory that is used, for example IBM Tivoli
Directory Server V6.2, or Microsoft Active Directory.

v The user ID and password that are used to bind to the LDAP server. This user
ID must be unique, for example, cn=root. Important: To create users and groups
through the Web GUI, the LDAP bind ID must have the appropriate permissions
in the LDAP directory. The bind ID must contain no spaces.

v The subtree of the LDAP directory that you want to be used for authenticating
users.

About this task

The configuration steps in this task use the sample LDAP directory that is
described in “Sample LDAP data” on page 40. Replace the values from this sample
with your own.

Procedure
1. Make a backup copy of the JazzSM_HOME/config/cells//wim/config/

wimconfig.xml file.
2. Log in as the administrative user, typically scadmin, and launch the

WebSphere®:
a. From the menu on the left, click Settings > WebSphere Administrative

Console.
b. Click Launch WebSphere Administrative Console.

3. Click Security > Global Security

4. Under User account repository, select Federated Repositories from the
Available realm definitions list and then click Configure.

5. Click Add repositories (LDAP, custom, etc)... and then click New Repository >
LDAP repository.

6. Add the LDAP directory as a repository to the realm by completing the
following fields:

Repository identifier
Type TIVIDS. The repository identifier uniquely identifies the repository
within the realm.

Directory type
Select the type of LDAP server. The type of LDAP server determines
the default filters that are used by WebSphere Application Server. IBM
Tivoli Directory Server users can select either IBM Tivoli Directory
Server or Secure Way, but IBM Tivoli Directory Server offers
performance. For OpenLDAP directories, select Custom.
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Primary host name
Type the fully qualified host name of the primary LDAP server. You
can enter either the IP address or the domain name system (DNS)
name.

Port Type the port of the LDAP directory. The host name and the port
number represent the realm for this LDAP server in a mixed version
nodes cell. The default port value is 389, which is not a Secure Sockets
Layer (SSL) connection port. Use port 636 for a Secure Sockets Layer
(SSL) connection. For some LDAP servers, you can specify a different
port.

Bind distinguished name
Type the bind ID of the LDAP server. If anonymous binds are not
possible on the LDAP server, the bind DN is for write-operations or to
obtain user and group information. Always provide a bind DN and
bind password, unless an anonymous bind can satisfy all of the
functions. If the LDAP server is set up to use anonymous binds, you
can leave these fields blank.

Bind password
Type the password of the bind ID.

After you completed the fields, click Apply, then click Save. The LDAP
directory is added to the repositories in the realm.

7. Define the repository by completing the following fields:

Distinguished name of a base entry that uniquely identifies this set of
entries in the realm

Example: o=TIVIDS. This distinguished name (DN) defines an entry for
the LDAP directory in the realm.

Distinguished name of a base entry in this repository 
Example: o=NetworkManagement,dc=myco,dc=com. This DN is the root of
the subtree in the LDAP directory that you want to use for
authentication.

Important: If you leave this field blank, the base entry is mapped to
the root of the LDAP directory. All operations are performed at root,
which causes errors on most LDAP servers.

After you completed the fields, click Apply, then click Save.
8. Restart the server.

Results

The users from the subtree of the LDAP directory are replicated in the realm. After
you restart the server, the users from the LDAP directory are visible on the
Manage Users page of the administrative console. The DN of the users consists of
the user prefix and suffix and the DN of the LDAP directory in the realm, in this
case o=TIVIDS, which represents the ou=NetworkManagementdc=myco,dc=com subtree.
For example, the administrator user has the DN
uid=Administr8or,cn=users,o=TIVIDS.

What to do next
v Configure VMM so that new users and groups that are created in the

administrative console are written to the LDAP directory.

42 IBM Operations Analytics Predictive Insights Managed: Configuration and Administration Guide



Configuring VMM to write to the LDAP directory
After you added the LDAP directory to the realm, make the LDAP directory the
repository to which new users and groups are written. The Virtual Member
Manager (VMM) component can read from multiple repositories but can write to
only a single repository. You can then use the user management functions in the
administrative console to create users and groups that are written to the LDAP
directory.

You need to configure the mapping between the LDAP objects, such as users and
groups, and the entity types of VMM that represent these objects. The entity types
are used to map the objects in different LDAP directories to a common object
model in VMM.

Before you begin

From your LDAP administrator, obtain the base entries in the LDAP subtree for
users and groups. These base entries are the locations in the LDAP subtree where
users and groups are created when users and groups are created through the
Manage Users page or the Manage Groups page in the administrative console.

Ensure that the LDAP bind ID has write-permissions in the LDAP directory.

About this task

The VMM supported entity types are Group, OrgContainer, and PersonAccount. A
Group entity represents a simple collection of entities that might not have any
relational context. An OrgContainer entity represents an organization, such as a
company or an enterprise, a subsidiary, or an organizational unit, such as a
division, a location, or a department. A PersonAccount entity represents a human
being. You cannot add or delete the supported entity types because these types are
predefined.

The configuration steps in this task use the sample LDAP directory described in
“Sample LDAP data” on page 40. Replace the values from this sample with your
own.

Procedure

To map the LDAP object types to the entity types in VMM:
1. Log in as the administrative user, typically scadmin,.
2. Open the administrative console:

a. From the menu on the left, click Setting > WebSphere Administrative
Console.

b. Click Launch WebSphere Administrative Console.
3. Click Security > Global Security

4. Under User account repository, select Federated Repositories from the
Available realm definitions list and then click Configure. Then, click Support
entity types.

5. Click each entity type and type the base entry from the LDAP directory in the
Base entry for the default parent , as follows, replacing the sample base entries
with the entries from your LDAP directory.
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Entity type Sample base entry

Group cn=groups,ou=NetworkManagement,
dc=myco,dc=com

OrgContainer ou=NetworkManagement,dc=myco,dc=com

PersonAccount cn=users,ou=NetworkManagement,
dc=myco,dc=com

6. Save the configuration for each entity type.
7. Restart the server.

Results

Users and groups that are created in the administrative console are now written to
the LDAP directory. It is now good practice to create users and groups only in the
administrative console or by using the tipcli command-line utility.

What to do next

Assign Web GUI roles to the LDAP users so that they can access Web GUI
functions, and so that they can be synchronized with the ObjectServer.

Assigning Web GUI roles to LDAP users and groups
Assign Web GUI roles to the LDAP users so that they have permission to use the
Web GUI functions.

About this task

If you assign the roles to groups, the authorizations that are associated with the
roles cascade to all users that are members of the groups.

The Web GUI roles do not give the users permission to write to the ObjectServer.
This permission is needed for certain Web GUI functions, for example, the Active
Event List (AEL) and the Web GUI tools. You set up this permission after you
assigned the Web GUI roles.

Write-permission to the ObjectServer can be granted only to Web GUI users that
have the ncw_admin role or the ncw_user role. Assign these roles to the users that
you want to synchronize to the ObjectServer.

Procedure

To assign Web GUI roles:
1. To assign roles to user groups:

a. Click Console Settings > Group Roles.
b. Complete any combination of the search fields to help locate the groups.
c. Select how many groups to display and click Search. A list of groups

appears in the grid.
d. Click the name of the group you want to assign roles to.
e. From the Role(s) list, select the roles to assign the user group.
f. Click Save.

2. To assign roles to users:
a. Click Console Settings > User Roles.
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b. Complete any combination of the search fields to help locate the users.
c. Select how many users to display and click Search. A list of matching users

appears in the grid.
d. Click the user ID of the user you want to assign roles to.
e. From the Role(s) list, select the roles to assign the user.
f. Click Save.

What to do next

Create the LDAP users in the ObjectServer by enabling the user synchronization
function.

Synchronizing LDAP users with the ObjectServer
After you defined the LDAP directory and assigned Web GUI roles to the LDAP
users, enable the user synchronization function. This function creates the LDAP
users in the ObjectServer, so that they can use all functions that write to the
ObjectServer. These functions include the Active Event List (AEL) and the the Web
GUI tools.

Before you begin

Ensure that the LDAP directory is running. If an ObjectServer was previously
added to the realm as a user repository, it needs to be removed. See Removing user
registries in the Tivoli Netcool/OMNIBus Knowledge Center.

Only Web GUI users that have the ncw_admin role or the ncw_user role can be
synchronized. Ensure that you assigned these roles to the required users.

Procedure

To enable user synchronization:
1. Edit the WEBGUI_HOME/etc/server.init file and set the users.credentials.sync

property to TRUE.
2. To change the name of the vmmusers user group, assign the required value to

the users.credentials.sync.groupname property.
3. Specify the intervals at which synchronization occurs:

a. Edit the ncwDataSourceDefinitions.xml file.
b. Set the maxAge attribute of the config property to the required time in

seconds. For example:
<config maxAge="time"/>

The default is 3600 seconds.
4. Restart the server.
5. If your environment is load-balanced, to enable user synchronization against

other nodes in the cluster repeat steps 1 to 4. On each additional node on
which you enable user synchronization, change the name of the user group, as
described in step 2. On each node of a load balanced environment, the name of
the user group that contains the synchronized users must be unique.

Results

The LDAP users and groups are synchronized with the ObjectServers that are
configured in the ncwDataSourceDefinitions.xml file. In an ObjectServer all
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synchronized users are assigned to the vmmusers group (or, whichever name is
specified by the users.credentials.sync.groupname property). If an ObjectServer
does not already contain this user group, it is created automatically. Every 3600
seconds (or whichever refresh interval is specified by the maxAge attribute), the
vmmusers group is resynchronized with the ObjectServer.

What to do next

Perform the following tasks:
v To enable synchronized users to connect to the ObjectServer and modify

ObjectServer data, for example by using the SQL interactive interface or by
running Web GUI tools, assign the following ObjectServer user groups:
– ISQL
– ISQLWrite

v To secure your network by using Secure Socket Layer (SSL) encryption, enable
SSL communications with the LDAP directory.

v To trigger a synchronization request manually, use the WEBGUI_HOME/bin/
webtop_osresynch tool. Before you use this tool, configure the WAAPI client. The
required methodName attribute is osresync.refreshOSCache.

46 IBM Operations Analytics Predictive Insights Managed: Configuration and Administration Guide



Chapter 4. Configuring integrations with other products

You can set up Operations Analytics Predictive Insights Managed to work with
other IBM® products. Read about necessary configuration tasks required to set up
the available integrations.

Configuring integration with IBM Performance Management

When you integrate Operations Analytics Predictive Insights Managed with IBM
Performance Management, Operations Analytics Predictive Insights Managed
analyzes the metric data collected by the Performance Management application
and generates alarms when it identifies anomalies in the data. Anomalies are
displayed in the Performance Management Dashboard as individual events
associated with the affected application, group, or component. You can then drill
down to the Operations Analytics Predictive Insights Managed User Interface to
view more details on an anomaly.

Before you begin

Before you can start the procedure to integrate Operations Analytics Predictive
Insights Managed and IBM Performance Management, you must:
v Install Operations Analytics Predictive Insights Managed. For more information,

see the Installing documentation in the Operations Analytics Predictive Insights
Managed Knowledge Center.

v Install IBM Performance Management. For more information, see the IBM
Performance Management Knowledge Center.

v Create a new directory on the Operations Analytics Predictive Insights Managed
server to hold the Operations Analytics Predictive Insights Managed Accelerator
for IBM Performance Management package, for example: mkdir
~/PI-APM-Accelerator-v1.0

v Download and extract the IBM Operations Analytics Predictive Insights
Managed Accelerator for IBM Performance Management package,
PI-APM-Accelerator-v1.0.zip, to the new directory.
For more information, see Downloading Operations Analytics Predictive Insights
Managed.

Configuring an Operations Analytics Predictive Insights
Managed model for Performance Management data sources

How to configure and deploy an Operations Analytics Predictive Insights Managed
model for Performance Management data sources.

About this task

A model file,apm_model.pamodel, for Performance Management data sources is
included in the integration pack. You must edit the model file to specify the details
of the two data sources that Operations Analytics Predictive Insights Managed can
use to process data generated by Performance Management agents. The two data
sources are:
v the pre-fetch database
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v a REST service referred to as the Kafka service bus

The file system data source must be a local directory on the Analytics server that
you mount via NFS on the Performance Management server. Later, you must
install a file consumer program on the Performance Management Server to read
metric data from the Kafka service bus and write it to the file system.

Procedure
1. Log in to the Operations Analytics Predictive Insights Managed as the

administrative user, typically scadmin.
2. Enter the following command to create an Operations Analytics Predictive

Insights Managed topic called ALL:
$PI_HOME/bin/admin.sh create_topic ALL

3. Enter the following commands to configure the topic:
$PI_HOME/bin/admin.sh set -t=ALL system.consolidate.alarms.correlations.enabled false -f
$PI_HOME/bin/admin.sh set -t=ALL system.consolidate.alarms.incident.enabled false -f
$PI_HOME/bin/admin.sh set -t=ALL system.consolidate.alarms.related_events.enabled false -f

4. Copy the apm_model.pamodel file to the /home/scadmin/apm_model directory on
the Operations Analytics Predictive Insights Managed server.

5. Edit the apm_model.pamodel file and customize the following values for your
APM environment:
<driver>com.ibm.db2.jcc.DB2Driver</driver>
<url>jdbc:db2://<APM_prefetch_ip_address>:<DB2_port>/WAREHOUS</url>
<schema>ITMUSER</schema>
<username><APM_prefetch_db_user></username>
<password><APM_prefetch_db_user_password></password>

Where:
<PI_install_dir> is the directory where Operations Analytics Predictive
Insights Managed was installed, by default /opt/IBM/scanalytics/analytics
<APM_prefetch_ip_address> is the IP address of a server where the APM
prefetch database is installed
<DB2_port> is the port used by Performance Management prefetch DB2
database, by default 50000
<APM_prefetch_db_user> is the Performance Management prefetch database
user, by default itmuser
<APM_prefetch_db_user_password> is the password for the APM prefetch
database user, by default db2Usrpasswd@08

6. Go to the end of the file and replace $APM_KAFKA_DS with /var/apm/files
<config xsi:type="tasp:FileSystemConfig" tzone="UTC"

timeFormat="yyyyMMdd-HH-mm"> <name>KAFKA</name> <path>$APM_KAFKA_DS</path>
<pattern>([a-zA-Z]\w*)__.*__(\d{8}-\d{2}-\d{2})UTC.*csv</pattern>

</config>

7. Save the apm_model.pamodel file.
8. Make sure that you have write permission to the /var/ directory and create

the following directory on the Operations Analytics Predictive Insights
Managed Server:
mkdir -p /var/apm/files
chmod 777 /var/apm/files

9. To import the apm_model.pamodel file in to the Mediation Tool, choose File
->Import ->Predictive Insights -> Predictive Insights Model.
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10. To deploy the model, from the menu, choose Predictive Insights->Deploy
Model. If multiple topics exist, select the topic to which you want to deploy
the model.

Exporting a directory from the Operations Analytics Predictive
Insights Managed server

You must export the /var/apm/files directory from the Operations Analytics
Predictive Insights Managed server so you can mount it on the Performance
Management server. Operations Analytics Predictive Insights Managed uses the
mounted directory as a datasource for metric data provided by the Kafka service
bus.

About this task

Procedure
1. Log in to the Operations Analytics Predictive Insights Managed as root.
2. Add the following line to the /etc/exports file to export the /var/apm/files

directory.
/var/apm/files <PM_ip_address>(rw,sync)

Where <PM_ip_address> is the IP address of the Performance Management
Server.

3. Enter the following command to reload the NFS service:
/etc/init.d/nfs stop

/etc/init.d/nfs start

4. Enter the following command to start NFS during server startup:
chkconfig --level 3 nfs on
chkconfig --level 5 nfs on

5. If you don't want to stop the firewall, add the following rule to iptables:
iptables -I INPUT 1 -s <PM_ip_address> -p tcp --dport 2049 -j ACCEPT

Note: You can add this rule permanently to the default iptables configuration
in /etc/sysconfig/iptables:
:OUTPUT ACCEPT [0:0]
-A INPUT -s <PM_ip_address> -p tcp --dport 2049 -j ACCEPT

After you add the rule, enter the following command to reload iptables:
/etc/init.d/iptables restart

Mounting a directory on the Performance Management Server
You must mount the directory that you exported from the Operations Analytics
Predictive Insights Managed server on the Performance Management Server.

About this task

Procedure
1. Log in to the Performance Management server.
2. Enter the following command to create a mount point:

mkdir -p /mnt/scapi/DefaultInstance

3. Enter the following command to mount the directory that you exported from
the Operations Analytics Predictive Insights Managed server:
mount -o tcp <PI_ip_address>:/var/apm/files /mnt/scapi/DefaultInstance
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Where <PI_ip_address> is the IP address of the Operations Analytics Predictive
Insights Managed server.

4. To ensure that the folder is mounted permanently, add the following line to the
/etc/fstab file:
<PI_ip_address>:/var/apm/files /mnt/scapi/DefaultInstance nfs rsize=8192,wsize=8192,timeo=14,intr

5. To verify that the mount point has been set correctly, do the following:
a. On the Performance Management server, as root, enter the following

command to create a test file:
echo “text” > /mnt/scapi/DefaultInstance/test

b. On the Operations Analytics Predictive Insights Managed server, as the
administrative user, typically scadmin, enter the following commands to
view and delete the test file:
cat /var/apm/files/test
rm -f /var/apm/files/test

If you can create the test file, display its content and delete the file, the mount
is configured correctly.

Configuring the File Consumer program
On the Performance Management server, the file consumer program reads metric
data from the Kafka service bus and write it to the Operations Analytics Predictive
Insights Managed server directory that is mounted on the Performance Managment
Server.

Procedure
1. On the Performance Management Server, log in as root.
2. Copy the com.ibm.tivoli.ccm.consumer.scapi.scapifileconsumer-1.0.eba file

from the directory on the Operations Analytics Predictive Insights Managed
server where you extracted the PI-APM-Accelerator-v1.0.zip file to the
<PM_installdir>/usr/servers/asfrest/dropins/ folder.
where <PM_installdir> is the directory where you installed Performance
Management. The default installation directory is: /opt/ibm/wlp.

3. Enter the following command to restart the asfrest process.
apm stop asfrest
apm start asfrest

Setting up the EIF Gateway

Installing the EIF gateway
How to install the EIF gateway.

About this task

Procedure
1. Navigate to the directory that contains the extracted IBM Operations Analytics

Predictive Insights Managed1.3.4 installation package.
2. Unzip the EIF package file, im-nco-g-tivoli-eif-4_0.zip file.
3. Enter the following command to start the Installation Manager wizard:

./IBMIM

4. In the main Installation Manager window, click File-> Preferences->
Repositories and add the repository.config file to the repository.
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5. Follow the installation wizard and select the default options to complete the
installation.

Configuring the EIF gateway

About this task

Procedure
1. Copy the configuration file from <omnihome>/gates/tivoli_eif/

NCO_GATES.props to <omnihome>/etc/NCO_GATES.props
2. Uncomment the Common Netcool/OMNIbus properties ensuring that the path

in the logs are correct.(note: look at appendix A)
3. Uncomment the Common Gateway properties ensuring that the path in the

logs is correct.
4. Uncomment the TIVOLI EIF Gateway properties ensuring that the path in the

logs is correct.

Configuring the Object Server for the Gateway

Procedure

To load the sql commands contained in the <omnihome>/gates/tivoli_eif/
tivoli_eifgw_setup.sql file, enter the following comamnd:
omnihome>/bin/nco_sql -server NCOMS -user root -password ’’ < <omnihome>/gates/tivoli_eif/tivoli_eifgw_setup.sql

Updating the Gateway mapping file

Procedure
1. Edit the $OMNIHOME/gates/tivoli_eif/tivoli_eif.map file.
2. Replace the contents of the file with the following:

CREATE LOOKUP Status_Table (
{0 , ’N’})

DEFAULT = ’Y’ ;

CREATE MAPPING StatusMap
(

’situation_name’ = ’Anomaly Detected’,
’situation_origin’ = ’@TASPAnomalousResources’,
’server_handle’ = ’’,
’date_reception’ = ’@FirstOccurrence’,
’event_handle’ = ’’,
’extdata1’ = ’@TASPIdentifier’,
’source’ = ’IBM SCAPI’,
’sub_source’ = ’@TASPAnomalousResources’,
’sub_origin’ = ’’,
’hostname’ = ’’,
’last_modified_time’ = ’@InternalLast’,
’adapter_host’ = ’’,
’situation_status’ = Lookup(’@Severity’,’Status_Table’),
’administrator’ = ’’,
’acl’ = ’’,
’severity’ = ’@Severity’,
’date’ = ’@LastOccurrence’,
’duration’ = ’0’,
’situation_displayitem’ = ’@TASPAnomalousMetrics’,
’msg’ = ’@Summary’,
’msg_catalog’ = ’’,
’msg_index’ = ’0’,
’num_actions’ = ’1’,
’credibility’ = ’0’,
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’repeat_count’ = ’0’,
’situation_time’ = ’@LastOccurrence’,
’cause_date_reception’ = ’0’,
’integration_type’ = ’U’,
’situation_type’ = ’S’,
’appl_label’ = ’PI:A:S’,
’master_reset’ = ’’,
’situation_thrunode’ = ’@TASPAnomalousResources’,
’cause_event_handle’ = ’0’,
’from_user’ = ’root’,
’to_user’ = ’root’);

3. Save the $OMNIHOME/gates/tivoli_eif/tivoli_eif.map file.

Updating the EIF configuration file

Procedure
1. Edit the <omnihome>/gates/tivoli_eif/tivoli_eif_config file.
2. Enter the IP address of the Performance Management server in the following

line:
c1ServerLocation=<PM Server IP>

3. Enter the destination EIF port used on the Performance Management server in
the following line:
c1Port=<port>

Starting the EIF gateway

Procedure
1. Change to the bin directory:

cd <omnihome>/bin

2. To start the gateway, enter the following command:
./nco_g_tivoli_eif &

3. To verify that the gateway started successfully, enter the following command to
check that the gateway process is running:
ps -ef | grep nco_g_tivoli_eif

Updating the probe rules file

About this task

Procedure
1. Log in to the Operations Analytics Predictive Insights Managed server as the

administrative user, typically scadmin.
2. Back up the <PI_installdir>/probe/omnibus/probes/linux2x86/stdin-

tasp.rules file:
cp stdin-tasp.rules stdin-tasp.rules.backup

3. Edit the stdin-tasp.rules file.
4. Add the following contents to the file before the last }.

# Added for APM integration
$PrimaryResource = extract($TASPMetricResourceNameList + ";", "([^;]*);")
@TASPAnomalousResources = $Node
update(@TASPAnomalousResources)

if (match($Node,$PrimaryResource)) {
# Do nothing as non-compound resource key
} else {
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# Extract secondary resource from compound resource key
$last_index = length($PrimaryResource) + 1
$node_index = length($Node) + 2
$node_length = length($Node)
$SecondaryResource = substr($PrimaryResource,int($node_index),int($last_index)-int($node_length))
@TASPAnomalousMetrics = @TASPAnomalousMetrics + "_Subsystem[" + $SecondaryResource + "]"
update(@TASPAnomalousMetrics)

}

# Set TASPAnomalousMetrics to Node for consolidated alarms (for clearing purposes)
if (regmatch(@Class, "89360")) {
@TASPAnomalousMetrics = @Node
update(@TASPAnomalousMetrics)
}

# Clear and children of a consolidated alarm to prevent them displaying in APMUI
if (regmatch(@TASPParentIdentifier, ".*TASP.*")) {
@Severity = 0
update(@Severity)
@Type = 2update(@Type)
}

Configuring integration properties
How to configure the integration properties on the Performance Management
server.

About this task

You must set integration propreties to:
v Integrate the Performance Management User Interface with the Operations

Analytics Predictive Insights Managed User Interface.
v Set the URL for the Operations Analytics Predictive Insights Managed Service

Diagnosis view. This URL will be used to launch in context from a Performance
Management event to the Operations Analytics Predictive Insights Managed
User Interface.

Procedure
1. Log in to the Performance Management server as root.
2. Enter the following commands to set the URL for the Operations Analytics

Predictive Insights Managed Service Diagnosis UI:
curl -X DELETE -u "smadmin:apmpass" -k

"https://localhost:8091/1.0/monitoring/systemconfig/services/com.ibm.tivoli.ccm.apmui/configitem/apmSCAPILink”

curl -X POST -d "{\"encrypted\": \"false\",\"uiorder\": \"30\",\"duplicated\":
\"false\",\"name\": \"apmSCAPILink\",\"uivisibility\":
\"false\",\"value\": \"https://<PI_ip_address>:9998/predictiveinsights/jsp/wlp/wlpAnomalyView.jsp?\",\"service\":
\"com.ibm.tivoli.ccm.apmui\",\"datatype\": \"STRING\",\"readonly\":
\"false\",\"cfgrequired\": \"false\"}" -u "smadmin:apmpass" -k
"https://<PM_ip_address>:8091/1.0/monitoring/systemconfig/services/com.ibm.tivoli.ccm.apmui/configitem" --header
"Content-Type:application/json"

Where:
<PM_ip_address> is the IP address of the server where Performance
Management is installed.
<PI_ip_address> is the IP address of the server where Operations Analytics
Predictive Insights Managed is installed.

3. To verify that the URL was set correctly, open your browser and go to the
following URL:
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https://<PM_ip_address>:8091/1.0/monitoring/systemconfig/services/com.ibm.tivoli.ccm.apmui/configitem/apmSCAPILink

4. Edit the <PM_install_dir>/usr/servers/apmui/apps/customCfg/
common.properties file:
Where <PM_install_dir> is the directory where Performance Management is
installed, by default /opt/ibm/wlp.

5. Locate the enableSCAPIIntegration property and set its value to true:
enableSCAPIIntegration = true

6. Enter the following commands to restart APMUI and server1:
apm stop apmui
apm start apmui
apm stop server1
apm start server1

Tuning the Operations Analytics Predictive Insights Managed
server

How to tune the Operations Analytics Predictive Insights Managed server.

Procedure
1. Log in to the Operations Analytics Predictive Insights Managed server as the

administrative user, typically scadmin.
2. Enter the following command to stop Operations Analytics Predictive Insights

Managed.
$PI_HOME/bin/stop.sh

3. Set the following system parameters:
$PI_HOME/bin/admin.sh set -t=ALL system.topic.extraction.queue 800000 -f
$PI_HOME/bin/admin.sh set -t=ALL system.topic.timeout.intervals 20 -f

4. Enter the following command to start Operations Analytics Predictive Insights
Managed.
$PI_HOME/bin/start.sh

5. Enter the following command to start data extraction:
$PI_HOME/bin/admin.sh run_extractor_instance

Scheduling cleanup of data files
How to create cron entries to perform periodic cleanup of data files on the
Operations Analytics Predictive Insights Managed server.

Procedure
1. Log in to the Operations Analytics Predictive Insights Managed server as the

administrative user, typically scadmin.
2. Enter the following command to edit the crontab file:

crontab -e

3. Add the following lines to the crontab file:
0 * * * /bin/find <PI_install_dir>/var -type f \( -name *.csv -o -name *.csv.bad -o -name *.ctrl \) -mtime +1 | xargs gzip
15 0 * * * /bin/find <PI_install_dir>/var -type f \( -name *csv.gz -o -name *.csv.bad.gz -o -name *.ctrl.gz \) -mtime +20 |
xargs rm -f
30 0 * * * /bin/find /var/apm/files/*d -type f -name *csv -mtime +1 | xargs gzip
45 0 * * * /bin/find /var/apm/files/*d -type f -name *csv.gz -mtime +7 | xargs rm

4. Save the crontab file.
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Chapter 5. Analyzing data

After you configure your model and deploy it to the database, the next step is to
start consuming and analyzing data.

Procedure
1. Set the main configuration parameters for Operations Analytics Predictive

Insights Managed.
a. Set the aggregation interval.
b. Configure purge

2. Start Operations Analytics Predictive Insights Managed and run the extractor
3. Monitor the training and extraction status using the AEL

What to do next

The details of how to implement these steps are contained in the following
sections.

Setting the aggregation interval
Data is normalized to the same interval so it can be processed by an analytics
instance.

Procedure
1. Log in as the administrative user, typically scadmin,.
2. Change to: $PI_HOME/bin.

Where $PI_HOME is the installation location of the analytics component.
3. Run the set command using the Operations Analytics Predictive Insights

Managed administration CLI application by entering the command:
./admin.sh set -t=<topic name> system.aggregation.interval <desired interval>

Where
v <topic name> is the name of the topic.
v <desired interval> is the aggregation interval in minutes.

Example
./admin.sh set -t=Topic1 system.aggregation.interval 15

Consider how often data is arriving when you set the aggregation interval. You
must try to match the aggregation interval with the arrival rate of data within your
system. The available intervals are 5, 10, 15 and 60 minutes.

Note: With a 60-minute aggregation interval, the data is heavily averaged and will
not show small changes. As a result, it is more difficult for Operations Analytics -
Predictive Insights to perform early detection of anomalies.

If you use a 60-minute aggregation interval, it is recommended that you make the
following configuration changes:
v Set the nofm.error.count.min.size property to 2
v Set the nofm.error.count.window.size property to 3.
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With these settings, an alarm is generated if a metric is anomalous for two of the
last three intervals, instead of the default, which requires that a metric is
anomalous for three of the last six intervals. As a result, Operations Analytics
Predictive Insights Managed can detect anomalies that exist for a shorter period of
time and generate alarms accordingly.
Related reference:
The set CLI command
The set CLI command.

Configuring purge
Configuring the data purge option. The purge is an optional step to configure how
long data is stored in the database. Retaining data for a longer period requires
more disk space and can impact UI response times.

About this task

This task describes how to set the details of data purge. The default purge setting
is to purge metric data older than 15 days.

Note: When loading backlog data, the timestamps for the alarms may not match
the timestamps of the associated data and as such the alarms will be retained
while the data is purged. Note that alarms deleted from the Operations Analytics
Predictive Insights Managed database will no longer be accessible from your Event
Management system and so you should ensure a similar cleanup is performed on
your Event Management system.

To configure how long data is stored in the database:

Procedure
1. Change to the $PI_HOME/bin/ directory.

Where $PI_HOME is the installation location of the analytics component.
2. Set the system.metric.retention.days property using the set command:

./admin.sh set -t=<topic_name> system.metric.retention.days <number_of_days>

Where <topic_name> is the name of the topic and <number_of_days> is the
number of days you wish to retain data.

Note: For more information about the set command, see “set” on page 92.

Extracting data
Use the run_extractor_instance command to extract data.

About this task

The data extracted from your datasource is consumed in two ways, it is used to
train your analytics model, and when an analytics model is available, the data is
then analyzed for any anomalies. There are five types of extraction:
v Steady state mode: This form of extraction is the simplest and involves

Operations Analytics Predictive Insights Managed reading in current, incoming
data from your datasource. The main issue with this method is it takes time for
your system to train and create an analytics model for each algorithm, which is
required before the algorithm can start to identify anomalies. Operations
Analytics Predictive Insights Managed creates a model for an individual
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algorithm when it has consumed fifty percent of the number of days data
specified for the <algorithm name>maxTrainingWindowDays configuration
property.

v Backlog mode: This form of extraction involves the reading in of recent
historical data. If you are intent on processing only backlog data, you must set
the start and end time when calling the command run_extractor_instance for
the first time. Only supply the stop time and not the start time when making
any subsequent calls to the command run_extractor_instance.

v Switch: This form of extraction is a hybrid of steady state mode and backlog
mode, the purpose of which is to create an analytics model as quickly as
possible using Backlog mode and move on to Steady state mode to begin the
analysis of current data.

v Extract Only: If you have multiple data sources with a variety of latencies and
you wish to extract backlog data, it is good practice to run
run_extractor_instance in EXTRACT_ONLY mode. The result of this will be that
the extracted data will be placed in your extracted folder for the topic, and then
you can use the REPLAY_RAW mode to process this data. This method ensures all
data is available for processing by run_extractor_instance.

v Replay Raw: This form of extraction takes previously extracted data from the
Operations Analytics Predictive Insights Managed folder $PI_HOME/var/spool/
topics/<topic>/extracted, where <topic> is the name of your topic. This
extraction type is typically used if you have extracted previously in
EXTRACT_ONLY mode, or if you have decided to cleanup and reprocess your data.

Procedure
1. Log in as the administrative user, typically scadmin,.
2. Change to: $PI_HOME/bin.

Where $PI_HOME is the installation location of the analytics component.
3. Run the run_extractor_instance as per one of the defined types. The following

sections describe how you can use the run_extractor_instance command to
extract data as per one of the defined types.

Extracting data in backlog mode
Run the run_extractor_instance command in backlog mode in order to consume
and analyze backlog data.

About this task

A typical scenario might be that you have three months of backlog data you wish
to process using Operations Analytics Predictive Insights Managed.

Procedure
1. Log in as the administrative user, typically scadmin,.
2. Change to: $PI_HOME/bin.

Where $PI_HOME is the installation location of the analytics component.
3. Run the run_extractor_instance command. The start and end time set for the

run_extractor_instance command defines the total amount of data that will be
processed, that is, the total amount of backlog data you want to process.
./admin.sh run_extractor_instance -t=Topic1 -s=20130801-0000 -e=20130829-1200

4. Monitor the progress alarms displayed on the Active Event List to observe the
status of data consumption.
You will notice alarms of the type:
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v Training is complete
v Extraction is complete
The run_extractor_instance command will automatically suspend and resume
the extraction of data to allow Operations Analytics Predictive Insights
Managed time rebuild the analytics model. The analytics model is rebuilt
regularly in order to keep the model relevant to the current data.

Note: If at any point you have to restart the extraction process because of some
issue, run the command specifying the end time and not the start time.

Supplying the start time the first time you run the command means extractions
starts from your selected time. The extraction process if stopped will pick up
from the last timestamp it processed. Allowing the extraction process pick the
start time for all but the first running of the command means you will not miss
any data, which may occur if you manually set the start time for every time the
run_extractor_instance command is run.

5. The anomalies generated based on the analyzed data will not be visible in the
AEL as they are historical alarms. To see these anomalies using the Operations
Analytics Predictive Insights Managed UI, you must use the Service Diagnosis
Anomaly Search.

Related reference:
“run_extractor_instance” on page 89
The run_extractor_instance CLI command.

Extracting data in switch mode
Run the run_extractor_instance command to extract initially in backlog mode
and then switch to steady state mode. If you have available backlog data this is the
most efficient data extraction type to use.

About this task

A typical scenario might be that you want to extract initially in backlog mode and
then switch to steady state mode, for example, extract 28 days of backlog data and
then continue to process incoming data.

Procedure
1. Log in as the administrative user, typically scadmin,.
2. Change to: $PI_HOME/bin.

Where $PI_HOME is the installation location of the analytics component.
3. Run the run_extractor_instance command. The start and end time set for the

run_extractor_instance command defines the total amount of data that will be
processed, that is, the total amount of backlog data you want to process.
./admin.sh run_extractor_instance -t=Topic1 -s=20130814-0000 -l=20

The start time specified, 20130814-0000 in this example, is the start time of the
backlog data. If, for example, you wish to extract 28 days of backlog data, set
the start time to be 28 days in the past. If you don't specify an end time,
extraction continues indefinitely.
The -l parameter specifies the latency, in minutes, that will be applied when
extraction switches to steady state mode. Set this value based on the number of
minutes delay in the arrival of data to your datasource. The default latency is
set to the same value as the system.aggregation.interval property.
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4. Monitor the progress alarms displayed on the Active Event List to observe the
status of data consumption.
You will notice alarms of the type:
v Training is complete
v Extraction is complete
The run_extractor_instance command may suspend and resume the extraction
of data to allow Operations Analytics Predictive Insights Managed time to
rebuild the analytics model. The analytics model is rebuilt regularly in order to
keep the model relevant to the current data.

5. The anomalies generated based on the analyzed data will be visible in the AEL
as they are based on current data.

Related reference:
“run_extractor_instance” on page 89
The run_extractor_instance CLI command.

Extracting data in steady-state mode
Run the run_extractor_instance command to extract current incoming data only.

About this task

The steady state mode is used when you want to process current incoming data
only

Procedure
1. Log in as the administrative user, typically scadmin,.
2. Change to: $PI_HOME/bin.

Where $PI_HOME is the installation location of the analytics component.
3. Run the run_extractor_instance command.

./admin.sh run_extractor_instance -t=Topic1 -l=20

The -l parameter specifies the latency, in minutes, that is applied when
extraction switches to steady state mode. Set the latency based on the number
of minutes delay in the arrival of data to your datasource. The default latency
is set to be the same value as the system.aggregation.interval property.

4. The anomalies generated based on the analyzed data will be visible in the AEL
as they are based on current data.

Related reference:
“run_extractor_instance” on page 89
The run_extractor_instance CLI command.

Extracting data in replay raw mode
Run the run_extractor_instance command to replay existing and previously
extracted data.

Before you begin

To extract data in REPLAY_RAW, you must have run the extractor on a previous
occasion.
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About this task

Extracting data in replay raw mode is of use if you have had to reconfigure or
update your data model, and you want to avoid waiting for the system to process
new data.

The following is an example of how this can be done:

Procedure
1. Log in as the administrative user, typically scadmin.
2. Change to: $PI_HOME/bin.

Where $PI_HOME is the installation location of the analytics component.
3. Run the stop command.

./stop.sh

4. Make a copy of the files and put them somewhere. All previously extracted
data for a given topic is stored in the Operations Analytics Predictive Insights
Managed folder $PI_HOME/var/spool/topics/<topic>/extracted, where <topic>
is the name of your topic. The files previously extracted may be split between
the good and bad subfolders.

5. Run the cleanup command.
./admin.sh cleanup

6. Deploy your updated data model.
7. Run the start command.

./start.sh

8. Put the files you copied into the $PI_HOME/var/spool/topics/<topic>/
extracted directory, where <topic> is the name of your topic.

9. Run the run_extractor_instance command.
./admin.sh run_extractor_instance -t=Topic1 -m=REPLAY_RAW -s=20130814-0000

The start time specified, 20130814-0000, is the start time of your backlog data
(REPLAY_RAW can be considered backlog data). After all the backlog data is
consumed, extraction stops. To resume extraction, you must first restart
Operations Analytics Predictive Insights Managed. Then run the extractor in
steady state mode. For more information, see “Extracting data in steady-state
mode” on page 59.

Example
./admin.sh run_extractor_instance -m=REPLAY_RAW -s=20140501-0000 -e=20140601-0000

The command replays the data between these dates. If data has already been
run-through it will be discarded.
./admin.sh run_extractor_instance -m=REPLAY_RAW -s=20140501-0000

Replay all the data on the OS starting from 1st of May, and ending when all files
have been read. Extractor will stop. No more data will be read through. It will not
transition to steady state.

Restart Operations Analytics Predictive Insights Managed:
cd $PI_HOME/bin
./stop.sh -t=<topicName>
./start.sh -t=<topicName>

Resume extraction in steady state mode:
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./admin.sh run_extractor_instance -m=EXTRACT -s=20140601-0000

Related reference:
“run_extractor_instance” on page 89
The run_extractor_instance CLI command.

Extracting data after restart
How to run the run_extractor_instance command if your Operations Analytics
Predictive Insights Managed system is restarted.

Procedure
1. Log in as the administrative user, typically scadmin.
2. Change to: $PI_HOME/bin.

Where $PI_HOME is the installation location of the analytics component.
3. Run the run_extractor_instance command in one of the following ways:
v Restart: If extractor for some reason gets stopped, you can run the following:

./start.sh

./admin.sh run_extractor_instance -l=20

Leaving out a start time means the extractor will pick up from the last
extracted time.

v System down time: In the event that your Operations Analytics Predictive
Insights Managed system experiences down time, you may build up a
significant backlog. Should this backlog span a day or more, you must
process this data as described in the Backlog mode example scenario.

Related reference:
“run_extractor_instance” on page 89
The run_extractor_instance CLI command.

Checking status
How to check the status of training and of data flow to Operations Analytics
Predictive Insights Managed.

About this task

Before Operations Analytics Predictive Insights Managed can begin identifying
anomalies it must first create an analytics model. Operations Analytics Predictive
Insights Managed provides a set of progress alarms which give you status on the
progress of your training, plus the data flow to your Operations Analytics
Predictive Insights Managed system.

To check the status of your training and data flow:

Procedure
1. Log in to the same Tivoli Integrated Portal or Dashboard Application Services

Hub instance as your Operations Analytics Predictive Insights Managed user
interface.

2. Select the Active Event List.
The Active Event List displays the list of detected anomalies and progress
indicator alarms. Progress indicator alarms are raised with a severity of Low.
The following are the set of possible status and progress indicator alarms:

Topic status message
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The availability of your data through the created topic or topics is
essential before data flow can begin for Operations Analytics Predictive
Insights Managed. The display of the following message indicates that
data is available for extraction:
v Topic Data Source started for topic: <topic_name>, ready to

start data loading

Extraction status messages

Extractors pull the data from your data source allowing Operations
Analytics Predictive Insights Managed to first train and then analyze
your data. Extraction is done on a per topic basis. The following
messages indicate whether extraction is in progress for a given topic:
v Extractor started for topic: <topic_name> and datasource:

<datasource_name>

v Extractor stopped for topic: <topic_name> and datasource:
<datasource_name>

Training progress messages

Training is the first stage of data analysis. A training or analytics model
must be constructed before Operations Analytics Predictive Insights
Managed is able to identify anomalies. After the initial training period,
data analysis can begin. Operations Analytics Predictive Insights
Managed will retrain by default once a day to keep the analytics model
current. The delay between each training can be increased for
individual algorithms using the <algorithim
name>.retrainingIntervalMinutes configuration property. The
following messages indicate whether training is in progress and its
level of completeness:
v Started receiving new data for training to begin.

v Received 25% of necessary data for training to begin.

v Received 50% of necessary data for training to begin.

v Received 75% of necessary data for training to begin.

v Received 100% of necessary data for training to begin.

v Finished Training. New model produced.

v New model training started with data between: <start_date_time>
and <end_date_time> baselines and relationships will be updated
on completion.
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Chapter 6. Operations Analytics Predictive Insights Managed
administration

The administration tasks required to manage Operations Analytics Predictive
Insights Managed components.

All tasks that you must carry out to administer the Operations Analytics Predictive
Insights Managed system are described in the following sections.

Filtering alarms
You can filter the set of alarms output by using the filtered_alarms.txt file.

About this task

You can filter the set of alarms that are emitted from the Analytics server for any
resource, metric group and metric.

Procedure
1. Open the $PI_HOME/spl/instances/Analytics<topic name>/config/

filtered_alarms.txt file.
Where <topic name> is the name of the topic to which you want to apply the
filtering .

2. Use a wildcard or regular expression to specify the resource, metric group, or
metric and whether the condition means that the alarm is discarded or
forwarded.
The format of a condition must be as follows:
regex|wild,<resource name>,<metric group name>,<metric name>,<rule type>,
<threshold>,forward|discard|major|minor|warning|critical

Where:
v regex means use regular expressions.

Regular expression example: [Dd]isk_space_.*
v wild means use basic wildcard matching - supports '*' and '?' only.

Wildcard example: *_CPU*
v resource name specifies the name of the resource to filter
v metric group name specifies the name of the metric group to filter
v metric specifies the name of the metric to filter
v rule type sets the type of rule to include in the filter condition and can be

one of the following:
actual_expected checks if both the actual and expected values are less than
or equal to the threshold
actual_only checks only if the actual value is less than or equal to the
threshold
expected_only checks only if the expected value is less than or equal to the
threshold
delta checks if the difference between the actual and expected value is less
than or equal to threshold
higher checks if the actual value is higher than the expected value
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lower checks if the actual value is lower than the expected value
v threshold specifies the numerical value against which the rule type is

compared
v forward means forward all matching alarms.
v discard means discard all matching alarms.
v major means set the severity of all matching alarms to major
v minor means set the severity of all matching alarms to minor
v warning means set the severity of all matching alarms to warning
v critical means set the severity of all matching alarms to critical
v * or an empty string ensures that the test always passes for regex or wild.
The first condition that is matched is used.

Note: The filtered_alarms.txt file is read dynamically at every interval so
you do not need to restart Operations Analytics Predictive Insights Managed
after you update the file.

Example

The following are examples of filters:
v wild,*,*,*,forward

Forward all alarms -> no other rule will be read after.
v wild,,,,forward

Forward all alarms -> no other rule will be read after. (same as the previous
example - null equals all pass)

v wild,*,NTPROCSSRGroup,*,forward

Forward all metrics in the metric group NTPROCSSRGroup.
v wild,*,NTPROCSSRGroup,%*,forward

Forward all metrics that begin with the percent symbol (%) AND are in the
metric group NTPROCSSRGroup.

v regex,*,NTPROCSSRGroup,%.*,forward

Same as the previous example, but uses regular expressions instead of
wildcards.

v wild,*,NTPROCSSR*,*,discard

Discard all alarms that are emitted from metrics in the metric group
NTPROCSSRGroup.

v wild,*,*,*Space_Available*,forward
wild,*,*,*,discard

Forward alarms with metric names that contain Space_Available only.
v wild,brayz1*,UNIXDISKGroup,*,forward

wild,*,*,*,discard

Forward alarms with resource names that start with brayz1 and resource group
in UNIXDISKGroup only

v wild,brayz1*,UNIXDISKGroup,Inodes_Used,forward
wild,*,*,*,discard

Forward alarms with resource names that start with brayz1 and resource group
in UNIXDISKGroup and metric name Inodes_Used only

v wild,router-sw49.tut.com,ResptimeGroup,Maxresponsetime,delta,1000,discard
wild,router-sw49.tut.com,ResptimeGroup,Maxresponsetime,delta,2000,minor
wild,router-sw49.tut.com,ResptimeGroup,Maxresponsetime,delta,3000,major
wild,router-sw49.tut.com,ResptimeGroup,Maxresponsetime,critical

Gradually increases the severity of the alarm as the deviation between the actual
and expected values increases. If the delta of the actual and expected value is
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less than or equal to 1000 the alarm is discarded . If this condition is not met,
Operations Analytics Predictive Insights Managed checks the remaining lines
and sets the severity to the appropriate value depending on which condition is
met. For example, if the delta of the actual and expected values is greater than
2000 but less than 3000, the condition in the third line of the example is met and
the alarm severity is set to major.

v wild,router-nw57.tut.com,ResptimeGroup,Maxresponsetime,actual_only,50,minor

Set the severity of the alarm to minor if the actual value of the Maxresponsetime
metric is less than or equal to 50.

v wild,router-nw57.tut.com,ResptimeGroup,Maxresponsetime,actual_expected,100,minor

Set the severity of the alarm to minor if both the actual value and expected
value of the Maxresponsetime metric is less than or equal to 100.

v wild,*,*,*Totalbytes,expected_only,10000000,warning

If a metric name that ends with Totalbytes has a value less than or equal to
1,000,0000, set the severity of the alarm to warning.

Creating a topic
You must deploy each model that you create to a topic. A default topic is created
as part of the installation of the Analytics component. You can create additional
topics to segregate data analysis and presentation.

About this task

Topics allow you to segment your data in ways that are relevant to your business.
For example, you can create a topic and use it to group data that originates from a
specific service, application, or geography. The anomalies generated based on your
data can then be grouped and displayed by topic. Data in different topics are
analyzed independently of each other and no analysis takes place across topics.
When you deploy a new model, you are asked to choose the topic to which the
new model belongs.

Note: For file based data sources, do not set up multiple topics that point to the
same source location.

Procedure
1. Log on to the Operations Analytics Predictive Insights Managed Analytics

server as the administrative user, typically scadmin, and navigate to
$PI_HOME/bin.

Note: The $PI_HOME environment variable is set automatically when the user
logs in. However, if your user's shell has been running since before the
installation, you might need to exit and log in again.

2. Run the create_topic command for each topic you wish to create.
The create_topic command is one of the available commands within the admin
CLI application:
./admin.sh create_topic <topic name> <description>

Where:
v <topic name>: Is the name of the new topic. The topic name must be one

word between 3 and 10 characters long. It can contain alphanumeric
characters and the underscore character

v <description>: The topic description. The description should be enclosed in
double quotes if it contains spaces.

Chapter 6. Operations Analytics Predictive Insights Managed administration 65



For example:
./admin.sh create_topic network "Topic for network data"

What to do next

If the topic is no longer being used it can be deleted using the delete_topic
command.
Related reference:
“create_topic” on page 86
The create_topic CLI command.
“delete_topic” on page 86
The delete_topic CLI command.

Starting Operations Analytics Predictive Insights Managed
components

How to restart your Operations Analytics Predictive Insights Managed components
and system after an error or a system update.

About this task

The following instructions do not form part of Operations Analytics Predictive
Insights Managed mandatory configuration. You may want to start or stop your
Operations Analytics Predictive Insights Managed system for maintenance.

If you are starting the Operations Analytics Predictive Insights Managed system as
a whole, you must start components in the following order:
v DB2®

v Streams
v Tivoli Integrated Portal or Dashboard Application Services Hub

Starting the Operations Analytics Predictive Insights Managed
analytics component

Use the start.sh script to start the Operations Analytics Predictive Insights
Managed Analytics component.

Procedure
1. Change to the $PI_HOME/bin directory.
2. As the administrative user, typically scadmin, enter the following command to

start the Analytics component:
./start.sh [-t=<topic_name>]

The command starts the Operations Analytics Predictive Insights Managed
processing framework and any topic you specify. If you omit the -t parameter,
the command starts all topics on the server.

3. Run the admin.sh run_extractor_instance command: $PI_HOME/bin/admin.sh
run_extractor_instance to start extracting data from the data source. For more
information, see “Extracting data” on page 56.

start.sh
The start.sh script is used to start Operations Analytics Predictive Insights
Managed.
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Purpose

This script has the purpose of starting Operations Analytics Predictive Insights
Managed.
start.sh [-t=<topic_name>]

The script starts the loading of data by Operations Analytics Predictive Insights
Managed and starts the analytics instance.

You can use the -t=<topic_name> option to specify one topic, so processing of data
is started for that one topic.

Starting Tivoli Integrated Portal
If you want to use Tivoli Integrated Portal to display anomalies in the Operations
Analytics Predictive Insights Managed user interface, start Tivoli Integrated Portal.

Procedure
1. As the user that installed Tivoli Integrated Portal, change to the Tivoli

Integrated Portal directory. For example: /opt/IBM/tivoli/tipv2/profiles/
TIPProfile/bin/

Note: Start the Tivoli Integrated Portal as root user only if the IBM Tivoli
Network Manager V3.8 is installed on your system.

2. Run the startServer.sh script, passing the script the name of your Tivoli
Integrated Portal server: For example,
./startServer.sh server1

Starting Dashboard Application Services Hub
If you want to use Dashboard Application Services Hub to display anomalies in
the Operations Analytics Predictive Insights Managed user interface, start
Dashboard Application Services Hub and the Operations Analytics Predictive
Insights Managed UI.

Procedure
1. As the user that installed Dashboard Application Services Hub, change to the

Dashboard Application Services Hub directory. For example,
/opt/IBM/JazzSM/profile/bin

2. Run the startServer.sh script, passing the script the name of your Dashboard
Application Services Hub server: For example,
./startServer.sh server1

3. Log onto the server on which you installed the Operations Analytics Predictive
Insights Managed UI as the user that installed it.

4. Navigate to <Liberty_Install_Home>/UI/bin

Note: <Liberty_Install_Home> defaults to /opt/IBM/scanalytics
5. Run the following command

./pi.sh -start
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Starting DB2
You must start the DB2 database to start the Operations Analytics Predictive
Insights Managed database component.

Procedure
1. As the DB2 owner, for example, db2inst1, run the db2start script.
2. As the DB2 administrator user, for example, dasusr1, run the db2admin start

command.

Checking that all Operations Analytics Predictive Insights
Managed components started correctly

How to confirm that all components are running.

Procedure
1. For DB2:

Enter the command:
ps -ef|grep -i db2

The command returns something like the following text:
db2fenc1 4057 6594 0 Aug09 ? 00:00:00 db2fmp ( ,0,0,0,0,0,0,0,1,0,8a65b0,14,200014,2,0,1,109ffc0,

0x210000000,0x210000000,1600000,350007,2,77218058
root 6106 1 0 May23 ? 01:06:43 /opt/IBM/db2/V9/bin/db2fmcd
dasusr1 6272 1 0 May23 ? 00:00:03 /opt/IBM/dasusr1/das/adm/db2dasrrm
root 6594 1 0 May23 ? 00:00:00 db2wdog 0
db2inst1 6596 6594 0 May23 ? 01:55:51 db2sysc 0
root 6597 6596 0 May23 ? 00:00:01 db2ckpwd 0
root 6598 6596 0 May23 ? 00:00:01 db2ckpwd 0
root 6599 6596 0 May23 ? 00:00:01 db2ckpwd 0
db2inst1 6640 6594 0 May23 ? 00:24:45 db2acd 0 ,0,0,0,1,0,0,0,1,0,8a65b0,14,200014,2,0,1,1ffc0,

0x210000000,0x210000000,1600000,350007,2,a000f
dasusr1 6656 1 0 May23 ? 00:00:02 /opt/IBM/db2/V9/das/bin/db2fmd -i dasusr1 -m

/opt/IBM/db2/V9/das/lib/libdb2dasgcf.so.1
db2fenc1 7134 6594 0 May23 ? 00:01:13 db2fmp ( ,1,0,0,0,0,0,0,1,0,8a65b0,14,200014,2,0,1,22ffc0,

0x210000000,0x210000000,1600000,350007,2,2a002a
dasusr1 7940 1 0 May23 ? 00:00:03 /opt/IBM/db2/V9/das/bin/db2fmd -i dasusr1 -m

/opt/IBM/db2/V9/das/lib/libdb2dasgcf.so.1
db2fenc1 14681 6594 0 May23 ? 00:00:13 db2fmp ( ,0,0,0,0,0,0,0,1,0,8a65b0,14,200014,2,0,1,85ffc0,

0x210000000,0x210000000,1600000,350007,2,88802d

2. For Streams:
a. Enter the command:

streamtool lspe -i spl

If you see stopped processes, then investigate the reason or contact IBM
services.
To recover, run $PI_HOME/bin/stop.sh, make the change needed to resolve
the problem, then run $PI_HOME/bin/start.sh.

3. Depending on whether you are using Tivoli Integrated Portal or Dashboard
Application Services Hub, perform the appropriate steps:

Tivoli Integrated Portal

a. Enter the command:
ps -ef|grep -i tip

The returned text looks something like:
root 22502 1 0 Aug07 pts/10 00:12:09 /opt/IBM/tivoli/tipv2/java/bin/java
<...> TIPCell TIPNode server1

b. Log in to the Tivoli Integrated Portal console. For example, by navigating to
https://hostname.ibm.com:<port>/ibm/console/logon.jsp, and confirm the
login is successful.

Dashboard Application Services Hub

a. Enter the command:
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ps -ef|grep -i jazzsm

The returned text looks something like:
root 23237 1 0 Jul01 ? 01:04:04 /opt/IBM/WebSphere/AppServer/java/bin/java
<...> JazzSMNode01Cell JazzSMNode01 server1

b. Log in to the Dashboard Application Services Hub console. For example, by
navigating to https://hostname.ibm.com:<port>/ibm/console/logon.jsp,
and confirm the login is successful.

Stopping Operations Analytics Predictive Insights Managed
components

You might want to stop the Operations Analytics Predictive Insights Managed
components and system to carry out some system maintenance.

About this task

If you are stopping the Operations Analytics Predictive Insights Managed system
as a whole, you must stop components in the following order:
v Tivoli Integrated Portal or Dashboard Application Services Hub
v Streams
v DB2

Stopping DB2
You must stop the DB2 database to stop the Operations Analytics Predictive
Insights Managed database component.

About this task

Procedure
1. As the DB2 owner, for example, db2inst1, run the db2stop script.
2. As the DB2 administrator user, for example, dasusr1, run the db2admin stop

command.

Stopping Tivoli Integrated Portal
If you are running Tivoli Integrated Portal, you must stop this application to stop
the Operations Analytics Predictive Insights Managed user interface.

Procedure
1. As the user that installed Tivoli Integrated Portal, change to the Tivoli

Integrated Portal directory.
For example: /opt/IBM/tivoli/tipv2/profiles/TIPProfile/bin/.

Note: Stop the Tivoli Integrated Portal as root user only if the IBM Tivoli
Network Manager V3.8 is installed on your system.

2. Run the stopServer.sh script, passing the script the name of your Tivoli
Integrated Portal server and your Tivoli Integrated Portal login and password:
./stopServer.sh <tip_server> -username <username> -password <password>

For example:
./stopServer.sh server1 -username tipadmin -password tipadmin
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Stopping Dashboard Application Services Hub
If you are running Dashboard Application Services Hub, you must stop this
application to stop the Operations Analytics Predictive Insights Managed user
interface.

Procedure
1. Log onto the server on which you installed the Operations Analytics Predictive

Insights Managed UI as the user that installed it.
2. Navigate to <Liberty_Install_Home>/UI/bin

Note: <Liberty_Install_Home> defaults to /opt/IBM/scanalytics
3. Run the following command

./pi.sh -stop

4. As the user that installed Dashboard Application Services Hub, change to the
Dashboard Application Services Hub directory.
For example, /opt/IBM/JazzSM/profile/bin.

5. Run the stopServer.sh script, passing the script the name of your server and
your Dashboard Application Services Hub login and password:
./stopServer.sh <dash_server> -username <username> -password <password>

For example:
./stopServer.sh server1 -username smadmin -password smadmin

Stopping InfoSphere Streams
You must stop InfoSphere Streams to stop the Operations Analytics Predictive
Insights Managed analytics component.

Procedure
1. Change to the directory: $PI_HOME/bin
2. As the administrative user, typically scadmin,, stop all analytics instances with

the following command:
./stop.sh -s

The -s option indicates that Streams must be stopped as well. Stopping
Streams stops all analytics instances.

stop.sh
The stop.sh script is used to stop Operations Analytics Predictive Insights
Managed.

Purpose

This script has the purpose of stopping Operations Analytics Predictive Insights
Managed.
stop.sh -s [-t=<topic_name>]

If you don't specify a parameter, the script stops data processing for all topics but
does not stop InfoSphere Streams.

You can use the -s parameter to stop Infosphere Streams. If you stop Infosphere
Streams, data processing is stopped for all topics.

You can use the -t=<topic_name> option to stop an individual topic.
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Backing up and restoring data

To prevent the loss of information in the event of a disaster, and for disaster
recovery, back up your Operations Analytics Predictive Insights Managed
configuration and data from the following locations:
v DB2 database
v $PI_HOME/states directory
v $PI_HOME/var/spool/topics/*/extracted directories. Create a rolling backup of,

at a minimum, the last 2 weeks of data.

If you need to perform a disaster recovery, restore the DB2 database to recover
configuration information including the mediation models. Then, restore the
$PI_HOME/states directory to restore the models created during training. After you
reapply any customizations you made to, for example, the OMNIbus probe rules
file, the filtered_alarms.txt file, or log settings, your Operations Analytics Predictive
Insights Managed system is then ready to resume analyzing data and generating
alerts.

Note: The rolling backup of the $PI_HOME/var/spool/topics/*/extracted directory
provides the data to quickly train a new installation of Operations Analytics
Predictive Insights Managed if the database recovery and/or a states recovery is
unsuccessful.

Maintaining passwords
If you change the passwords for the users of systems that are integrated with
Operations Analytics Predictive Insights Managed, such as, InfoSphere Streams and
DB2, you must also update these passwords for Operations Analytics Predictive
Insights Managed.

Changing a Tivoli Integrated Portal user password
You change the Tivoli Integrated Portal user password by updating the password
in Tivoli Integrated Portal.

About this task

The instructions for changing a Tivoli Integrated Portal user's password are
contained in the Tivoli Integrated Portal information center.

Note: Operations Analytics Predictive Insights Managed does not store a copy of
this password, so you do not have to make any Operations Analytics Predictive
Insights Managed specific changes.

Procedure
1. Change to the Tivoli Integrated Portal Knowledge Center section, Changing

Tivoli Integrated Portal passwords.
2. Follow the instructions on how to change your own password with the Change

Your Password portlet.
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Changing a Dashboard Application Services Hub user
password

You change the Dashboard Application Services Hub user password by updating
the password within Dashboard Application Services Hub.

Procedure
1. Log into DASH as the user for which you want to change passwords.

2. Click on the user icon ( ) in the menu bar.
3. Click the Change Password option.

Note: Operations Analytics Predictive Insights Managed does not store a copy
of this password, so you do not have to make any change to Operations
Analytics Predictive Insights Managed as a result of the password change.

Changing a Tivoli Integrated Portal administrator password
You change the Tivoli Integrated Portal administrator password by updating the
password in Tivoli Integrated Portal.

About this task

The instructions for changing a Tivoli Integrated Portal administrator's password
are contained in the Tivoli Integrated Portal Knowledge Center.

Note: Operations Analytics Predictive Insights Managed does not store a copy of
this password, so you do not have to make any Operations Analytics Predictive
Insights Managed specific changes.

Procedure
1. Change to the Tivoli Integrated Portal Knowledge Center section, Changing

Tivoli Integrated Portal passwords.
2. Follow the instructions on how to change a password with the Manage Users

portlet.

Changing the Tivoli Netcool/OMNIbus ObjectServer user
password

If you change the ObjectServer user password in Tivoli Netcool/OMNIbus, you
must also update the password that is stored in Operations Analytics Predictive
Insights Managed and in Dashboard Application Services Hub, if you are using
Dashboard Application Services Hub.

Before you begin

For information on how to change the Tivoli Netcool/OMNIbus ObjectServer user
password in Tivoli Netcool/OMNIbus, open the Tivoli Netcool/OMNIbus
Knowledge Center, select the version of OMNIbus that you are using, and search
for Changing the password for the connection to the ObjectServer.
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About this task

Procedure
1. To set the new ObjectServer user password in Operations Analytics Predictive

Insights Managed, as the administrative user, typically scadmin, enter the
following command on the analytics server:
$PI_HOME/bin/admin.sh passwd $PI_HOME/config/omnibus.connection.properties connection.password

When prompted to enter the new connection password, enter the new
password set for the ObjectServer user.

2. To set the new ObjectServer user password in Dashboard Application Services
Hub, as the administrative user, typically scadmin, enter the following
command on the UI server:
/opt/IBM/scanalytics/UI/bin/changeOmnibus.sh --password=<password>

where <password> is the new password set for the ObjectServer.

Changing a Dashboard Application Services Hub
administrator password

You change the Dashboard Application Services Hub administrator password by
updating the password in Dashboard Application Services Hub.

Procedure
1. Log in to Dashboard Application Services Hub as administrator.

2. Click on the user icon ( ) in the menu bar.
3. Click the Change Password option.

Note: Operations Analytics Predictive Insights Managed does not store a copy
of this password, so you do not have to make any change to Operations
Analytics Predictive Insights Managed as a result of the password change.

Changing the database user password
If you change the password of the UNIX account that is configured as the database
user, default scadmin, you must also update the password in Operations Analytics
Predictive Insights Managed. The database user password is encrypted in the
$PI_HOME/config/tasp.connection.properties file. You must also update the
password in your visualization application, Dashboard Application Services Hub
or Tivoli Integrated Portal.

About this task

To change the DB2 database user password:

Procedure
1. On the Analytics server, log in as the administrative user, typically scadmin,.
2. Change to the $PI_HOME/bin directory.
3. Enter the following command syntax:

./admin.sh passwd $PI_HOME/config/tasp.connection.properties connection.password

The following message is displayed
Enter connection.user password:
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4. Enter the new password that was set for the database user account.
5. Enter the following commands to restart Operations Analytics Predictive

Insights Managed.
cd $PI_HOME/bin
./stop.sh
./start.sh

6. To set the new password in Dashboard Application Services Hub, on the UI
server, enter the following command:
/opt/IBM/scanalytics/UI/bin/changeDatabase.sh --password=[value] [options]

Where options are:
v --databaseName=<value> is the name of the Operations Analytics Predictive

Insights Managed database.
v --serverName=<value> is the server where the Operations Analytics

Predictive Insights Managed database is located.
v --portNumber=<value> is the port number that is used by the Operations

Analytics Predictive Insights Managed database.
v --user=<value> is the user name of the Operations Analytics Predictive

Insights Managed database user. 
v --show shows the configuration details for the Operations Analytics

Predictive Insights Managed database.
7. To set the new password in Tivoli Integrated Portal, on the UI server, enter the

following command:
/opt/IBM/tivoli/tipv2/products/tasp/tasp/bin/configure.sh -tipuser <tipuser> -tippassword <tippassword> -type jdbc
-driverhome <driverhome> -dburl <jdbcurl> -dbuser <jdbcuser> -dbpassword
<jdbcpassword>

Where:
v <tipuser> is the user name used to connect to Tivoli Integrated Portal.
v <tippassword> is the password used to connect to Tivoli Integrated Portal.
v <driverhome> is where the JDBC driver can be found.
v <dburl> is the JDBC URL for the Operations Analytics Predictive Insights

Managed data source. 
v <dbuser> is the user name for connecting to the Operations Analytics

Predictive Insights Managed data source.
v <dbpassword> is the password for connecting to the Operations Analytics

Predictive Insights Managed data source.

Note: After you set the password, you must restart Tivoli Integrated Portal so
it uses the updated password. The password change will fail if the input values
are invalid.
Example:
./configure.sh -tipuser tipadmin -tippassword tipadmin007 -type jdbc
-driverhome /opt/IBM/tivoli/tipv2/products/tasp/tasp/lib
-dburl jdbc:db2://hostname.ibm.com:50000/TASPDB8
-dbuser dbuser -dbpassword userdb007
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Changing the DB2 instance owner password
You change the DB2 database instance owner password by updating the password
in DB2.

About this task

The instructions on how to change the DB2 instance owner's password are
contained in the DB2 information center.

Note: Operations Analytics Predictive Insights Managed does not store a copy of
this password, so you do not have to make any Operations Analytics Predictive
Insights Managed specific changes.

To change the DB2 database instance owner password:

Procedure
1. Go to the DB2 Knowledge Center and open the section Maintaining passwords

on servers.
2. Follow the instructions on how to change passwords.

Changing the InfoSphere Streams administrator password
You change the InfoSphere Streams administrator password by updating the
password in InfoSphere Streams, and you must also update the password that is
stored in the Operations Analytics Predictive Insights Managed system.

About this task

For IBM InfoSphere® Streams 3.2 the default admin user that is created upon
installation is scadmin.

To change the InfoSphere Streams admin user password:

Procedure
1. Change to the IBM InfoSphere Streams Knowledge Center and update the

Streams administrator password as described for your security service in the
section Setting up user authentication for Streams.

2. If you enable file extraction, for example, you have a remote system that FTPs
CSV files to your Operations Analytics Predictive Insights Managed system,
then you must update the password for the FTP on the remote system.

Changing the database data source password
You change the Operations Analytics Predictive Insights Managed database data
source password by updating the password within the Mediation tool.

About this task

If a database owner changes the password for a database data source, extraction
from that data source is blocked until you update the password for the database
data source in the Mediation tool.

The symptoms of a change in database password by the database owner are:
v No extraction or merge files being created.
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v TopicDataSourceALL_trace_DataSource.log displays an error: “User or Password
invalid”.

In the Mediation tool, you see the following symptoms:
v Test Connection fails,
v Show Table Content fails,
v Synchronize Schema fails,
v Data Extraction Preview fails and
v Deploy fails with User ID or Password invalid.

You update the password in the Connection Details tab in the Mediation tool. For
a failed Deploy, the password must be updated in the “Password required for data
source” pop-up dialog.

Procedure
1. Stop Operations Analytics Predictive Insights Managed. For example:

cd $PI_HOME/bin
./stop.sh

2. Start the Mediation tool.
3. Open the model that you deployed for extraction.
4. Click the Connection Details tab.
5. In the Password field, update the password to the correct password.
6. Save the model.
7. Within the Predictive Insights Navigator pane, select the model.
8. Click Predictive Insights > Deploy Model.
9. The Predictive Insights Model Deployment dialog opens, in which you enter

the Operations Analytics Predictive Insights Managed database connection
details and password.

10. Update the data source password in the Password required for data source
window.

11. Click OK.
12. Start Operations Analytics Predictive Insights Managed. For example:

cd $PI_HOME/bin
./start.sh

13. Continue extraction from the last extracted time.
./admin.sh run_extractor_instance
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Chapter 7. Event management administration

Administration of the event management system.

Configuring alarm forwarding from the Analytics server to an OMNIbus
ObjectServer

The Analytics server forwards alarms to an OMNIbus ObjectServer so that they
can be displayed in the Active Event List.

About this task

You only need to complete this procedure if you did not set up alarm forwarding
to an OMNIbus ObjectServer when you installed the Analytics component or if
you want the Analytics component to forward alarms to a different OMNIbus
ObjectServer.

Procedure
1. Change to the directory: $PI_HOME/bin.

Where $PI_HOME is the installation location of the Analytics component.
2. As the administrative user, typically scadmin, enter the following command:

./configure_omnibus -enable -installdir=<directory> -isuser=<streams user>
-omniname=<instance> -omniuser=<omnibus user> -omnihost=<host> -omniport=<port>
-omnipwd=<password> -t=<topic>

Where:
v directory is the installation directory for the Analytics component. For

example, /opt/IBM/scanalytics/analytics.
v streams user is the user name of the InfoSphere Streams user. For example,

scadmin.
v instance is the OMNIbus instance name. For example, NCOMS.
v omnibus user is the OMNIbus user name. The default user name is root.
v host is the OMNIbus server host name. For example, hostname.tiv.ibm.com.
v port is the OMNIbus port number. For example, 4100.
v password is the OMNIbus server admin password.
v topic is the name of the Operations Analytics Predictive Insights Managed

topic. For example, Topic1.

Adding the OMNIbus Operations Analytics Predictive Insights
Managed columns to the Active Event List

Operations Analytics Predictive Insights Managed provides a customized view and
filter that displays all the relevant alarm information in the Active Event List.

About this task

You choose the customized view and filter in the Active Event List.

© Copyright IBM Corp. 2011, 2016 77



Procedure
1. Log in to your Visualization application, Dashboard Application Services Hub

or Tivoli Integrated Portal.
2. Open the Active Event List (AEL):
v If you are using Dashboard Application Services Hub, click the Incident icon,

, and choose Active Event List (AEL).
v If you are using Tivoli Integrated Portal, click Availability, Events, and choose

Active Event List (AEL).
3. In both the filter and view drop-down lists, change the value from Default to

PredictiveInsights.

Generating the OMNIbus interfaces file
OMNIbus component communications information is saved in an interfaces file,
which is needed by the Tivoli Directory Server communications layer.

Procedure
1. On the OMNIbus server, as the OMNIbus administrator or user, run the

nco_igen utility to generate the interfaces file:
<netcool_home>/bin/nco_igen

where <netcool_home> is typically /opt/IBM/tivoli/netcool
If OMNIbus is running on a non-Linux architecture, you must pass the -all
option to the utility. The utility generates an architecture-specific interfaces file
for Linux in: <netcool_home>/etc/interfaces directory.

2. As the InfoSphere Streams user, for example scadmin, copy the interfaces file to
the $PI_HOME/probe/etc directory on the Operations Analytics Predictive
Insights Managed analytics server.
Where $PI_HOME is the installation location of the analytics component.

Customizing the OMNIbus probe rules file
The OMNIbus probe rules file defines how the OMNIbus probe processes event
data that it receives from Operations Analytics Predictive Insights Managed. After
processing, the probe sends the event data to the OMNIbus Object Server as an
alert.

The default probe rules file is: $PI_HOME/probe/omnibus/probes/linux2x86/stdin-
tasp.rules.You can customize the default file for your environment. To ensure that
any updates to the probe rules file are read by the system, run a kill
 -9 on the probe process after you save the file.

The following are examples of customizations you can make to the default probe
rules file.

Increasing the severity of alarms raised on service-impacting
metrics

You can customize the default probe rules file to increase the severity of certain
alarms. For example, some metrics that are monitored by Operations Analytics
Predictive Insights Managed have a direct user impact. Such metrics include
service response time and service availability. To increase the severity of these
alarms, update the following section of the probe rules file:
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# Compute alarm severity depending on whether the potentially anomalous KPI(s)
# contain a service-impacting KPI.
# You will need to update this statement to reflect your TASP implementation.
if (int($TASPCorrelationId) >= 0) {

if (regmatch($TASPAnomalousMetrics, “Service_Impacting_KPI_1”
|| regmatch($TASPAnomalousMetrics, “Service_Impacting_KPI_2”)

) {
@Severity = 4

} else {
@Severity = 3

}
} else if (int($TASPCorrelationId) == -1) {

# Consolidated alarms - many problems in one alarm.
@Severity = 4

} else if (int($TASPCorrelationId) == -2) {
# Data Availability alarms
@Severity = 5

} else if (int($TASPCorrelationId) == -3) {
# Information Events should have a lower severity.
@Severity = 2

} else if (int($TASPCorrelationId) == -4) {
# System health alarms are very important.
@Severity = 5

}

# Map the data source severity directly, if it exists.
# Note: resolution events should be set to severity 1, the generic clear will

set them to 0 later
update(@Severity)

The $TASPAnomalousMetrics element contains the list of metrics that are detected as
anomalous by Operations Analytics Predictive Insights Managed. You can use the
$TASPAnomalousMetrics element to set the severity of the alarm.

You can replace Service_Impacting_KPI_1 and Service_Impacting_KPI_2 by the full
metric names, as configured by the mediation and visible in the Operations
Analytics Predictive Insights Managed User Interface. These include the metric
name but not the resource or node name.

You can also set the severity by using the resource names in
$TASPMetricResourceNameList. You can construct a
$TASPAnomalousMetricResourceNameList for this purpose. Follow the example for
$TASPAnomalousMetrics in the default probe rules file.

You must tune your probe rule file according to the configuration of your metrics
and groups. For example, if you have metrics with the same name in multiple
metric groups, setting the severity on individual metrics can set the severity on a
metric of the same name in an incorrect group.

Note: The probe log file for each topic is: /opt/IBM/scanalytics/analytics/probe/
omnibus/log/<topic name>Probe.log.

Setting a custom alarm summary

By default, Operations Analytics Predictive Insights Managed provides a summary
that shows the anomalous metric, its trend and actual and expected values. You
can change the details in the probe rules file. For example, you can use the names
of the anomalous metrics or resources:

# Set a custom summary for alarms impacting a specific service
if (regmatch($TASPAnomalousMetrics, “Service_Impacting_KPI_1”)) {

@Summary = “Anomaly detected on Service 1”
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} else {
@Summary = $Summary

}
update(@Summary)

Operations Analytics Predictive Insights Managed can generate alarms with several
metrics. Therefore, metrics from two different services can be included in a single
alarm. You can decide how you want to handle the scenario, for example, by
adding both service names in the summary.

Setting alarm severity based on attributes present in the event

You can set the severity of an alarm based on a particular attribute in the alarm.
The following example sets the alarm severity to Critical for any alarm that
contains an Infrastructure attribute.
if (regmatch($TASPAttributeNames, "Infrastructure"))
{
@Severity = 5
}
update(@Severity)

Related information:

http://www-01.ibm.com/support/knowledgecenter/SSSHTQ_8.1.0/
com.ibm.netcool_OMNIbus.doc_8.1.0/omnibus/wip/probegtwy/task/
omn_prb_debuggingrulesfiles.html
Debugging OMNIbus probe rules.

OMNIbus probe tokens
The list of Operations Analytics Predictive Insights Managed probe tokens for
OMNIbus.

The following table contains descriptions of the attributes that are provided by
Operations Analytics Predictive Insights Managed to the OMNIbus probe. These
attributes are available in the rules file.

Table 1. OMNIbus probe list

Element name Element description Sample

$Summary Contains the summary
information about the cause
of the alert.

ResponseTime is Higher than
expected. Actual: 3000
Expected: 100

$Identifier Contains the identifier
information of the alert.

id://PI/NETWORK/1_1_3_14145
06900000

$TASPActualValue The actual metric value at the
time of the anomaly

$TASPAlgorithmInstanceNameIndicates the algorithm
instance name.

AnomalyDetectiongen

$TASPAlgorithmName Indicates the predictive
algorithm name.

com.ibm.pi.analytics.normal
_bounds_model

$TASPAnomalousMetricGroupsThe metrics groups that the
metrics in this alarm that are
tagged as anomalous belong
to.

Generatedperf2Group

$TASPAnomalousMetrics The metrics in this alarm that
are tagged as anomalous.

Metric2
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Table 1. OMNIbus probe list (continued)

Element name Element description Sample

$TASPAnomalousResources The resources that the
metrics in this alarm that are
tagged as anomalous belong
to.

ResourceId_6

$TASPAnomalyTimestamp Indicates the anomaly time
stamp. The time stamp can
be set to some time in the
future in the case of
predictive alarms.

1/13/14 4:00:00 PM

$TASPCorrelationId Identifies the correlation, for
multivariate alarms.

7522

$TASPExpectedValue The expected metric value at
the time of the anomaly

$TASPInstanceIdentifier Identifies the Operations
Analytics Predictive Insights
Managed instance.

PI

$TASPMetricGroupNameListSpecifies a list of groups
names, delimited with 3
semi-colons, for the metrics
that were detected as
anomalous.

Generatedperf2Group;;;
Generatedperf2Group;;;
Generatedperf1Group;;;
Generatedperf1Group

$TASPMetricInformation Provides free text debug
information that contains a
human-readable summary of
the alarm.

Anomaly detected on 4
metrics:ResourceId_6.
Metric2 = 11000.0
[0.9669775188394545]
ResourceId_8.Metric2 =
174.92455 [0.40904027569
31195]ResourceId_1044.
Metric0 = 46.99705 [0.4155
66194969713]
ResourceId_1092.Metric0 =
38.38585 [0.181694578856197]

$TASPMetricNameList Specifies a list of metric
names, delimited with 3
semi-colons, that were
detected as anomalous.

Metric2;;;Metric2;;;Metric0
;;;Metric0

$TASPMetricNodeList Specifies a list of node
names, delimited with 3
semi-colons, for the metrics
that were detected as
anomalous. 'Node' is
analogous to the 'Node'
concept in OMNIbus.

ResourceId_6;;;ResourceId_8
;;;ResourceId_1044;;;
ResourceId_1092

$TASPMetricResourceNameListSpecifies a list of resource
names, delimited with 3
semi-colons, for the metrics
that were detected as
anomalous.

ResourceId_6;;;ResourceId_8
;;;ResourceId_1044;;;
ResourceId_1092

$TASPMetricResourceTypeListSpecifies a list of resource
types, delimited with 3
semi-colons, for the metrics
that were detected as
anomalous.

gen;;;gen;;gen;;;gen
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Table 1. OMNIbus probe list (continued)

Element name Element description Sample

$TASPMetricScoreList Specifies a list of metric
scores, delimited with 3
semi-colons, for the metrics
that were detected as
anomalous.

0.9669775188394545;0.409
0402756931195;;;
0.4175566194969713;0.1
81694578856197

$TASPMetricValueList Specifies a list of metric
values, delimited with 3
semi-colons, for the metrics
that were detected as
anomalous

11000.0;;;174.92455;;;
46.99705;;;38.38585

$TASPParentIdentifier Alarms can be consolidated
into one alarm. In this case
the parent identifier is set to
the Identifier of the
consolidated alarm. If you
use Operations Analytics
Predictive Insights Managed
OMNIbus views, only
consolidated alarms are
shown, and a right-click
menu option lets you display
child alarms of the
consolidated alarm.

$TASPQuantifier Indicates the quantifier for
this alarm.

0.9669775188394545

$TASPTopic The name of the topic that
includes the anomalous
metric.

gen

$TASPUpdateTime Indicates the wall-clock time
of the last update to this
alarm. The wall-clock time
could, for example, be used
for an analysis of the delay.

1/17/14 1:22:19 PM

$TASPActualValue The value of the metric at the
time the anomaly occurs

123

$TASPDirection The direction the metric
when compared to its
expected value

Lower

$TASPExpectedValue The expected value of the
metric at the time the
anomaly occurs

52

$TASPIdentifier The root identifier for the
anomaly

id://PI/NETWORK/1_1_3

$TASPAttributeNames A list of attribute names in
the alarm delimited with 3
semicolons

ServiceName;;;Node;;;OSType
;;;dataSourceType

$TASPAttributeValues A list of attribute values in
the alarm delimited with 3
semicolons

OnlineBanking;;;router-ne19.
tut.com;;;Linux;;;network

Note in particular the two different time stamps provided:
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Table 2. Timestamps

Timestamp Description

$TASPAnomalyTimestamp Timestamp of the predicted anomaly.

$TASPUpdateTime Wall-clock time stamp indicating when the
alarm was last updated. This may have no
relation with the other time stamp,
especially if back-processing data.
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Chapter 8. Reference

Use this information about Operations Analytics Predictive Insights Managed for
reference purposes.

Scripts and utilities
The Operations Analytics Predictive Insights Managed scripts available to the
Administrator.

You can run the administration scripts with following steps:
1. Log in as scadmin.
2. Change to the directory: $PI_HOME/bin
3. Launch the script; for example, launch the admin.sh script by entering the

command:
./admin.sh

admin.sh
The admin.sh script is used manage and maintain the overall system configuration.

To run the admin.sh script, do the following:
1. Log in as scadmin.
2. Change to the $PI_HOME/bin directory:
3. To run the script, type the following:

./admin.sh

4. To display the list of commands that you can use with the admin.sh script,
type:
help

cleanup
The cleanup CLI command.

Purpose

The purpose of this script is to clean up Operations Analytics Predictive Insights
Managed so you can replay raw files or re-extract data.
cleanup [-t=<topic name>]

Note: Before you can clean up a topic, you must stop all topics on the server
where the topic is located. To stop all topics and associated InfoSphere Streams
processes on the server, enter the following command $PI_HOME/bin/stop.sh -s.

The cleanup command deletes data, metadata, and the configuration model from
the database, but retains the schema. It also archives the following three folders to
$PI_HOME/BAK<datestamp> , for example, BAK20130808122747.
v $PI_HOME/states

v $PI_HOME/log

v $PI_HOME/var/spool/topics
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The command does not delete alarms from the Objectserver. If you need to delete
alarms, log in to Tivoli Integrated Portal or Dashboard Application Services Hub
and delete the relevant alarms.

After you clean up a topic, you must redeploy the configuration model from the
Mediation Tool and run the following command to start all topics:
$PI_HOME/bin/start.sh

Parameters

-t= <topicname>
Use this option to clean up a specific topic. If you don't specify a topic name,
the command performs a cleanup of all topics on the server.

Samples

This sample illustrates how to run the command:
./admin.sh cleanup -t=network

create_topic
The create_topic CLI command.

Purpose

This command creates a new topic in the system.
create_topic <topic name> <description>

Parameters

<topic name>
The name for the new topic. The topic name must be one word between 3 and
10 characters long. It can contain alphanumeric characters and the underscore
character.

Note: Topic names are created in uppercase, irrespective of the case you use to
specify the topic name. For example, if you specify a topic name of “Network”,
the topic name is created as “NETWORK”, which you see when you run the
“show_topics” on page 93 command. However, the topic name is not case
sensitive when you specify it as part of any other CLI command.

<description>
A description for the new topic. The description must be enclosed in double
quotation marks if it contains spaces.

Sample

This sample creates a topic that is named “network” with the description“network
data”:
./admin.sh create_topic network "network data"

delete_topic
The delete_topic CLI command.

Purpose

This command deletes a topic.
delete_topic <topic name>
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Parameters

<topic name>
The name of the topic to be deleted. To display a list of topics, use
show_topics.

Sample

This sample deletes the “network ” topic:
./admin.sh delete_topic network

deploy_data_model
The deploy_data_model command.

Purpose

This command deploys a model to a specified topic. You can use this command if,
for some reason, you are unable to deploy a model with the Mediation tool.
deploy_data_model -t=<topic name> -m=<model file>

Parameters

<topic name>
The name of the topic to deploy the model file to.

<model file>
The name of the model file to deploy.

Sample

This sample deploys the datasource.pamodel file to a topic called network:
./admin.sh deploy_data_model -t=network -m=/workspace/project/datasource.pamodel

exit
The exit CLI command.

Purpose

The exit command closes the administration application. The exit command is
required only when you run ./admin.sh.
exit

Parameters

There are no parameters.

Sample

This sample demonstrates how to exit the administration application:
exit

help
The help CLI command.
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Purpose

This command displays help information for the administration application.
help

Parameters

There are no parameters.

Sample

This sample demonstrates how to display the available help:
./admin.sh help

history
The history CLI command.

Purpose

This command displays the history of commands that are executed in the current
session of the administration application.

The total number of commands that are stored is four.
history

Parameters

There are no parameters.

Sample

This sample demonstrates how to display the current session history:

Note: To run the history command, you must first launch the admin.sh script and
then run the history command from the command line, as illustrated in this
sample.
./admin.sh

IBM Operations Analytics Predictive Insights 1.3 - 5725-K26

(C) Copyright IBM Corp. 2011,2015 All Rights Reserved.

>> help history

help: print command history.
USE: history
DESCRIPTION:

Prints the most recently typed user commands

>>history

help history
history

passwd
The passwd CLI command.
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Purpose

This command is used to update an encrypted password that is saved in a
property file. If the file exists, the appropriate property value is replaced. If the file
does not exist, a new file is created and appended with the new property.
passwd [-c] <filename> <property name>

Parameters

-c The file that is specified is new and has to be created.

<filename>
The name of the target file.

<property name>
The name of the target property.

Sample

This sample appends the property, “property”, to a new file called “passwordfile”:
passwd -c passwordfile property

quit
The quit CLI command.

Purpose

This command quits the administration application.
quit

Parameters

There are no parameters.

Sample

This sample demonstrates how to exit the administration application:
./admin.sh quit

run_extractor_instance
The run_extractor_instance CLI command.

Purpose

This command runs an extractor instance. It requires that you deploy a valid
configuration model to the Operations Analytics Predictive Insights Managed
system with the Operations Analytics Predictive Insights Managed configuration
tool.
run_extractor_instance -m=<mode> -s=<starttime>

[ -e=<endtime> -l=<latency> -t=<topicname>]

When running the command, remember the timezone differences between the
server that you are running the command on and server from which the data is
being taken. If the server you are running the command on has a timezone of
UTC+5, and the command you entered used -starttime 20130201-0000 (local);
when you convert to UTC, your command runs with -starttime 20130201-0500
(UTC).
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Parameters

-m= <mode>
The mode of extraction.

The following are the available modes:
v EXTRACT - Extract from data source using the deployed configuration model.

If you don't specify a mode, the command uses EXTRACT by default.
v EXTRACT_ONLY - Only extract to raw files. Do not load into Operations

Analytics Predictive Insights Managed. EXTRACT mode does not support
the starting and stopping of individual extraction instances. The
APPLY_TO_ALL option must be used when running in EXTRACT mode.

v REPLAY_RAW - Replay previously extracted raw files. This is useful if an
updated model is deployed to the Operations Analytics Predictive Insights
Managed system. This mode replays previously extracted raw data files and
applies the updated model, for example, any different aggregators. On the
filesystem, this mode will move files from $PI_HOME/var/spool/topics/ALL/
extracted to $PI_HOME/var/spool/topics/ALL/extracted/good so if you need
to REPLAY_RAW again, you'll need to move files back to $PI_HOME/var/spool/
topics/ALL/extracted.

Note: The $PI_HOME/bin/admin.sh cleanup command will archive that data
to $PI_HOME/BAK* so you may need to retrieve the data from that archive in
order to run REPLAY_RAW.

-s= <starttime>
The start time of extraction. This is a mandatory parameter the first time the
run_extractor_instance command is run.

Supplying the start time the first time you run the command means extractions
starts from your selected time. The extraction process if stopped will pick up
from the last timestamp it processed. Allowing the extraction process pick the
start time for all but the first running of the command means you will not miss
any data, which may occur if you manually set the start time for every time
the run_extractor_instance command is run.

The start time is expressed in one of these formats:
v yyyyMMdd-hhmm Exact date.

For example, 20130301-10:15
v +-PxYxMxDTxHxMMxS Time relative to now. x is a positive integer and Y(year)

M(month) D(day) H(hour) M(minute) S(second).
For example, -P2DT4H30M equates to Two days four hours and 30 minutes
ago.

-e= <endtime>
The end time of the extraction period. This is an optional parameter. The
default is to continue to extract until stop_extractor_instance is called.

If backlog data is being loaded and an end time is not specified, extraction will
continue until the present time, and then the extractor will enter steady state
mode (that is, the reading in of current, incoming data). When the extractor
has swapped to steady state mode any further backlog data will be ignored. If
the data you want to process is purely backlog data, always specify an end
time.

The end time is expressed in one of these formats:
v yyyyMMdd-hhmm - Exact date.
v +-PxYxMxDTxHxMMxS - Time relative to now.
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-l= <latency>
If you specify a latency, the extractor only extracts data that is older than the
number of minutes you set for the latency value. The default latency is the
value of the system.aggregation.interval property.

-t= <topicname>
Runs extraction for a specific topic. If multiple topics exist on the server, -t is a
mandatory parameter.

Extraction

The data extracted from your datasource is consumed in two ways, it is used to
train your analytics model, and when an analytics model is available, the data is
then analyzed for any anomalies. There are five types of extraction:
v Steady state mode: This form of extraction is the simplest and involves

Operations Analytics Predictive Insights Managed reading in current, incoming
data from your datasource. The main issue with this method is it takes time for
your system to train and create an analytics model for each algorithm, which is
required before the algorithm can start to identify anomalies. Operations
Analytics Predictive Insights Managed creates a model for an individual
algorithm when it has consumed fifty percent of the number of days data
specified for the <algorithm name>maxTrainingWindowDays configuration
property.

v Backlog mode: This form of extraction involves the reading in of recent
historical data. If you are intent on processing only backlog data, you must set
the start and end time when calling the command run_extractor_instance for
the first time. Only supply the stop time and not the start time when making
any subsequent calls to the command run_extractor_instance.

v Switch: This form of extraction is a hybrid of steady state mode and backlog
mode, the purpose of which is to create an analytics model as quickly as
possible using Backlog mode and move on to Steady state mode to begin the
analysis of current data.

v Extract Only: If you have multiple data sources with a variety of latencies and
you wish to extract backlog data, it is good practice to run
run_extractor_instance in EXTRACT_ONLY mode. The result of this will be that
the extracted data will be placed in your extracted folder for the topic, and then
you can use the REPLAY_RAW mode to process this data. This method ensures all
data is available for processing by run_extractor_instance.

v Replay Raw: This form of extraction takes previously extracted data from the
Operations Analytics Predictive Insights Managed folder $PI_HOME/var/spool/
topics/<topic>/extracted, where <topic> is the name of your topic. This
extraction type is typically used if you have extracted previously in
EXTRACT_ONLY mode, or if you have decided to cleanup and reprocess your data.

show
The show CLI command.

Purpose

This command lists the properties that are configured for a specific topic.
show -t=<topic name>

Parameters

-t= <topic>
The topic name. Use “show_topics” on page 93 to display topic names.
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Sample

This sample illustrates how to show the properties for the network topic:
./admin.sh show -t=network

set
The set CLI command.

Purpose

This command sets a new value for a topic property.
set -t=<topic name> <property name> <property value>

Parameters

-t= <topic name>
The topic name.

<property name>
The property name. Use “show” on page 91 to see the list of properties for a
topic.

<property value>
The new value for the property specified.

Sample

This sample changes the “system.alarm.autoclear” property to “false” for the
“Topic1” topic:
./admin.sh set -t=Topic1 system.alarm.autoclear false

show_data_model
The show_data_model CLI command.

Purpose

This command creates a file with details of the most recent data model that was
deployed to the specified topic.
show_data_model <topicname> <output filename>

Parameters

<topic name>
The name for the new topic. The topic name must be one word between 3 and
10 characters long. It can contain alphanumeric characters and the underscore
character.

Note: Topic names are created in uppercase, irrespective of the case you use to
specify the topic name. For example, if you specify a topic name of “Network”,
the topic name is created as “NETWORK”, which you see when you run the
“show_topics” on page 93 command. However, the topic name is not case
sensitive when you specify it as part of any other CLI command.

<output filename>
The name of the file to which you want the command to write the details for
the data mode.
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Sample
./admin.sh show_data_model network /tmp/networktopic.txt

show_kpi_counts
The show_kpi_counts CLI command.

Purpose

This command displays the average number of KPIs that Operations Analytics
Predictive Insights Managed processed in the last day, week, and month. The
average number of KPIs is the total number of KPIs processed in the time period
divided by the number of intervals in the time period.
show_kpi_counts -t=<topicname>

Parameters

-t=<topic name>
The name of the topic for which to display the average KPI count. If you don't
specify the -t parameter, the command shows the average KPI count for all
installed topics.

Sample
./admin.sh show_kpi_counts -t=network

show_topics
The show_topics CLI command.

Purpose

This command displays installed topics.
show_topics [ALL]

Parameters

There are no parameters.

Sample

This sample illustrates how to display all installed topics on this Analytics server
only:
./admin.sh show_topics

This sample illustrates how to display all installed topics on every Analytics server
in this system:
./admin.sh show_topics ALL

show_version
The show_version CLI command.

Purpose

This command displays the current version of Operations Analytics Predictive
Insights Managed.
show_version

The following is an example of the result displayed:
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1.3.3.1_201509271946

The first 4 digits from the left represent the version number of the product
followed by the build date and time. Within the version number, the first 3 digits
represents the base product version and the fourth digit identifies the last ifix
applied to the base product.

Note: You only see the ifix version if you updated the product version number
when you installed the ifix. The instructions on how to update the version number
are contained in the installation instructions provided with each ifix.

Sample

This sample illustrates how to display the current version of Operations Analytics
Predictive Insights Managed:
./admin.sh show_version

stop_extractor_instance
The stop_extractor_instance CLI command.

Purpose

This command stops the extraction for a defined period. It requires that you
deploy a valid configuration model to the Operations Analytics Predictive Insights
Managed system with the Operations Analytics Predictive Insights Managed
administration tool.
stop_extractor_instance -t=<topicname>

Parameters

-t= <topicname>
You can use this option to stop extraction for a specific topic. If you don't
specify a topic name, the default action is to stop extraction for all topics.

Sample
./admin.sh stop_extractor_instance

update_memory
The update_memory admin command.

Purpose

This command updates the memory settings and threads for the topic, using the
values contained in the specified filename.
update_memory <topicname> <filename>

The memory and thread settings must be calculated based on the number of KPIs
being processed by Operations Analytics Predictive Insights Managed and the
number of topics you are using. For more information, see Memory recommendations
under Performance and Sizing on the Operations Analytics Predictive Insights
Managed wiki.

Parameters

<filename>
The name of the file from which to take the memory settings. The first line of
the file must have a header in the format:
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operator,-Xmx,-Xms,-Xgcthreads

Underneath the header, you set the values for an operator in the format:
<operator name>,<Xmx value>,<Xms value>,<Xgcthreads value>

Where:
v <operator name> is the operator name. Valid operators are:

DataSourceOperator, AnalyticsOperator, SelfMonitorOperator,
PostProcessingOperator, OmnibusConfigurator, RossiDecorator and
CorrelationDbWriter.

v <Xms value> is the initial java heap size for the operator. After the value,
specify m if the value is in megabyes or g if the value is in gigabytes.

v <Xmx value> is the maximum java heap size for the operator. After the
value, specify m if the value is in megabyes or g if the value is in gigabytes.

v <Xgcthread value> is the number of threads to assign to the operator.

For example:
operator,-Xmx,-Xms
DataSourceOperator,6g,6g
ModelTrainer,20g,20g
ModelEvaluator,6g,6g
RossiDecorator,8g,8g

Sample
./admin.sh update_memory network /tmp/memorysettings.txt

collect.sh
How to use the collect.sh script.

Purpose

Use the collect.sh script to collect information to send to IBM if, for example, you
encounter a problem that you cannot resolve.

To run the command:
$PI_HOME/collect.sh [-t= <topic name> ] [-o=<output_folder>]

For example:
$PI_HOME/bin/collect.sh -t=network /tmp/

You must then send the output to IBM.

If any other files get copied to this directory, they must be sent along with the
collect.log file.

Parameters

<topic name>
The name for the new topic. The topic name must be one word between 3 and
10 characters long. It can contain alphanumeric characters and the underscore
character.

Note: Topic names are created in uppercase, irrespective of the case you use to
specify the topic name. For example, if you specify a topic name of “Network”,
the topic name is created as “NETWORK”, which you see when you run the
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“show_topics” on page 93 command. However, the topic name is not case
sensitive when you specify it as part of any other CLI command.

<directory>

The <directory> parameter is optional. This parameter can be used to specify
an alternative location to which scripts output is written.

By default the output is written to a subdirectory of the current directory
called: collect_output.

Samples

This sample illustrates the running of the script, plus how to check the output of
the script:
cd $PI_HOME/bin
./collect.sh -t=network /tmp/

Checking the output:
ls -l ⌂/collect_output/
total 28
-rw-rw-r-- 1 scadmin scadmin 24696 Mar 30 08:40 collect.log

start.sh
The start.sh script is used to start Operations Analytics Predictive Insights
Managed.

Purpose

This script has the purpose of starting Operations Analytics Predictive Insights
Managed.
start.sh [-t=<topic_name>]

The script starts the loading of data by Operations Analytics Predictive Insights
Managed and starts the analytics instance.

You can use the -t=<topic_name> option to specify one topic, so processing of data
is started for that one topic.

stop.sh
The stop.sh script is used to stop Operations Analytics Predictive Insights
Managed.

Purpose

This script has the purpose of stopping Operations Analytics Predictive Insights
Managed.
stop.sh -s [-t=<topic_name>]

If you don't specify a parameter, the script stops data processing for all topics but
does not stop InfoSphere Streams.

You can use the -s parameter to stop Infosphere Streams. If you stop Infosphere
Streams, data processing is stopped for all topics.

You can use the -t=<topic_name> option to stop an individual topic.
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Properties
The properties that can be used to configure your Operations Analytics Predictive
Insights Managed environment.

Component properties
The configuration properties for individual Operations Analytics Predictive
Insights Managed components.

Component configuration properties are those properties that are specific to an
individual component, such as a specific algorithm or the User Interface. You can
display all the component configuration properties by using the following
command:
admin.sh show -t=<topic>

In the output, the names of the component configuration properties begin with the
name of the component to which the property applies. For example, in the
following sample list of component configuration properties, robustBounds relates
to the Robust Bounds algorithm and ui refers to the User Interface.
robustBounds.enabled: true
ui.granularity.default.min: 0
flatLine.maxTrainingWindowDays: 28
granger.enabled: true
nofm.error.count.window.size: 6
relatedEvents.enabled: true
variantInvariant.enabled: true

Use the set command to set a configuration property:
admin.sh set -t=<topic_name> <property> <value>

For more information about the set command, see “set” on page 92.

Note: Restart Operations Analytics Predictive Insights Managed to activate any
changes you make to component configuration properties.

flatLine.enabled
flatLine.enabled configuration property.

Description

When set to “true”, this property enables the Flatline algorithm to analyze your
data and generate alarms.

Property configuration information

Table 3. flatLine.enabled configuration information

Configuration Value

Type BOOLEAN

Default TRUE

flatLine.maxTrainingWindowDays
The flatLine.maxTrainingWindowDays configuration property.

Description
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Specifies the maximum amount of data that can be analyzed by the Flatline
algorithm to train a metric.

Note: The Flatline algorithm attempts to train when the smallest
maxTrainingWindowDays property for any algorithm, excluding
granger.maxTrainingWindowDays, is reached. To train a metric, the algorithm
requires that the metric has at least 50% data available relative to the value of the
flatLine.maxTrainingWindowDays property.

Property configuration information

Table 4. flatLine.maxTrainingWindowDays configuration information

Configuration Value

Type INTEGER

Default 14

Min 7

Max 28

flatLine.retrainingIntervalMinutes
The flatLine.retrainingIntervalMinutes configuration property.

Description

Specifies the interval, in minutes, at which retraining occurs for the Flatline
algorithm.

Table 5. flatLine.retrainingIntervalMinutes configuration information

Configuration Value

Type INTEGER

Default 1440

Min 0

Max 40320

granger.enabled
granger.enabled configuration property.

Description

When set to “true”, this property enables the Granger algorithm to analyze your
data and generate alarms.

Property configuration information

Table 6. granger.enabled configuration information

Configuration Value

Type BOOLEAN

Default TRUE

granger.maxTrainingWindowDays
The granger.maxTrainingWindowDays configuration property.
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Description

Specifies the maximum amount of data that can be analyzed by the Granger
algorithm to train a metric

Property configuration information

Table 7. granger.maxTrainingWindowDay configuration information

Configuration Value

Type INTEGER

Default 3

Min 1

Max 28

granger.maxSeasonalTrainingWindowDays
The granger.maxSeasonalTrainingWindowDays configuration property.

Description

Specifies the number of days of data that is required to train and produce a
seasonal model for the Granger algorithm.

uProperty configuration information

Table 8. granger.maxSeasonalTrainingWindowDays configuration information

Configuration Value

Type INTEGER

Default 14

Min 7

Max 28

granger.retrainingIntervalMinutes
The granger.retrainingIntervalMinutes configuration property.

Description

Sets the interval, in minutes, at which retraining occurs for the Granger algorithm.

Table 9. granger.retrainingIntervalMinutes configuration information

Configuration Value

Type INTEGER

Default 1440

Min 0

Max 40320

granger.threads
The granger.threads configuration property.
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Description

Sets the number of threads used by the Granger trainer.

Property configuration information

Table 10. granger.threads configuration information

Configuration Value

Type INTEGER

Default 4

Min 2

Max 64

nofm.error.count.min.size
The nofm.error.count.min.size configuration property.

Description

Minimum number of intervals a metric must be anomalous before Operations
Analytics Predictive Insights Managed raises an alarm.

This property must be used with nofm.error.count.window.size to establish the
error window.

The default configuration is as follows:
nofm.error.count.min.size: 3
nofm.error.count.window.size: 6

The default configuration generates an alarm, for a given metric, if the data for
that metric is seen as anomalous by an analytics instance for three of the last six
time intervals. With the default settings, if a metric is seen as anomalous for fewer
than three out of the last six intervals, no alarm is generated. The properties can
both be set to 1, which results in immediate alarms for all detected anomalies.

When a metric is flagged as anomalous for an interval, and the metric also goes
missing, that is, there is no data available for that metric, in a subsequent interval
or intervals; the metric is considered anomalous for the interval or intervals where
the metric data is missing. Therefore, with the default configuration, if a metric is
seen as anomalous for an interval and then it goes missing or is seen as anomalous
for two of the following five intervals, an alarm is generated.

Property configuration information

Table 11. nofm.error.count.min.size configuration information

Configuration Value

Type INTEGER

Default 3

Min 1

Max 30

nofm.error.count.window.size
nofm.error.count.window.size configuration property.
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Description

Window size in normalized periods to evaluate anomaly count for alarm filtering.
This property must be used with nofm.error.count.min.size to establish the error
window.

For example:
nofm.error.count.min.size: 3
nofm.error.count.window.size: 6

The default configuration generates an alarm, for a given metric, if the data for
that metric is seen as anomalous by an analytics instance for three of the last six
time intervals. With the default settings, if a metric is seen as anomalous for fewer
than three out of the last six intervals, no alarm is generated. The properties can
both be set to 1, which results in immediate alarms for all detected anomalies.

When a metric is flagged as anomalous for an interval, and the metric also goes
missing, that is, there is no data available for that metric, in a subsequent interval
or intervals; the metric is considered anomalous for the interval or intervals where
the metric data is missing. Therefore, with the default configuration, if a metric is
seen as anomalous for an interval and then it goes missing or is seen as anomalous
for two of the following five intervals, an alarm is generated.

Property configuration information

Table 12. nofm.error.count.window.size configuration property configuration information

Configuration Value

Type INTEGER

Default 6

Min 1

Max 30

relatedEvents.enabled
relatedEvents.enabled configuration property.

Description

When set to “true”, this property enables the Related Events algorithm, which
detects related events.

Property configuration information

Table 13. relatedEvents.enabled configuration information

Configuration Value

Type BOOLEAN

Default TRUE

relatedEvents.retrainingIntervalMinutes
The relatedEvents.retrainingIntervalMinutes configuration property.

Chapter 8. Reference 101



Description

Specifies the interval, in minutes, at which retraining occurs for the Related Events
algorithm.

Property configuration information

Table 14. relatedEvents.retrainingIntervalMinutes configuration information

Configuration Value

Type INTEGER

Default 1440

Min 0

Max 40320

robustBounds.enabled
robustBounds.enabled configuration property.

Description

When set to true, this property enables the Robust Bounds algorithm to analyze
your data and generate alarms.

Property configuration information

Table 15. robustBounds.enabled configuration information

Configuration Value

Type BOOLEAN

Default TRUE

robustBounds.maxTrainingWindowDays
The robustBounds.maxTrainingWindowDays configuration property.

Description

Specifies the maximum amount of data that can be analyzed by the Robust Bounds
algorithm to train each metric.

Note: The Robust Bounds algorithm attempts to train when the smallest
maxTrainingWindowDays property for any algorithm, excluding
granger.maxTrainingWindowDays, is reached. To train a metric, the algorithm
requires that the metric has at least 50% data available relative to the value of the
robustBounds.maxTrainingWindowDays property.

Property configuration information

Table 16. robustBounds.maxTrainingWindowDays configuration information

Configuration Value

Type INTEGER

Default 28

Min 7

Max 28
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robustBounds.retrainingIntervalMinutes
The robusBounds.retrainingIntervalMinutes configuration property.

Description

Sets the interval, in minutes, at which retraining occurs for the Robust Bounds
algorithm.

Table 17. robustBounds.retrainingIntervalMinutes configuration information

Configuration Value

Type INTEGER

Default 1440

Min 0

Max 40320

sta.corr.retention.days
sta.corr.retention.days configuration property.

Description

This property specifies the number of days to retain a correlation group in the
correlation table in the Operations Analytics Predictive Insights Managed database.

Property configuration information

Table 18. sta.corr.retention.days configuration information

Type INTEGER

Default 15

Min 5

Max 15

sta.corr.decorator.enabled
sta.corr.decorator.enabled configuration property.

Description

When set to true, this property enables the Correlation algorithm. The Correlation
algorithm can analyze your data and display, as a related metric, any metric that is
correlated with the anomalous metric.

Property configuration information

Table 19. sta.corr.decorator.enabled configuration information

Configuration Value

Type BOOLEAN

Default TRUE

ui.granularity.default.min
ui.granularity.default.min configuration property.
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Description

This configuration property sets the default granularity of data that is displayed in
the Operations Analytics Predictive Insights Managed User Interface.

Ideally this property is set so that it matches the granularity that is used by the
analytics component. The granularity that is used by the analytics component is set
with the system.aggregation.intervalparameter. With the default value, 0, set for
ui.granularity.default.min, the User Interface automatically uses the value set
for system.aggregation.interval. To view the value that is set for
system.aggregation.interval, run the following command:
$PI_HOME/bin/admin.sh show -t=<topic name>

Where <topic name> is the name of the topic for which you want to display
properties.

Note: To list the set of topics, run:
$PI_HOME/bin/admin.sh show_topics

If the raw data is of a finer granularity than that set for
system.aggregation.interval, and you want to view the data at that granularity,
then adjust this parameter appropriately.

If you have multiple topics configured and those topics have different settings for
ui.granularity.default.min and if you open KPIs from those topics into a shared
chart (for example, through a multi-select of alarms in the Active Event List), then
the granularity will become the lowest common multiple of the
ui.granularity.default.min settings. For example, if you open a KPI from a topic
with a ui.granularity.default.min setting of 15 minutes with a KPI from a topic
with a ui.granularity.default.min setting of 10 minutes then the chart will open
with a default 30 minute granularity.

Property configuration information

Table 20. ui.granularity.default.min configuration information

Configuration Value

Type INTEGER

Default 0

Min 5

Max 60

ui.summary.dlg.attr.names
The ui.summary.dlg.attr.names configuration property.

Description

Use this property to specify a comma-separated list of attribute that are visible
when you click the information icon in the summary pane in the Operations
Analytics Predictive Insights Managed User Interface. For example, to make
attributes called “Service”, “Node”, and “Application” visible, type the following:
$PI_HOME/bin/admin.sh set t=<topic name> ui.summary.dlg.attr.names
"Node,Service,Application"
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Property configuration information

Table 21. ui.summary.dlg.attr.names configuration information

Configuration Value

Type STRING

Default Node

ui.summary.dlg.favorite.attr.name
The ui.summary.dlg.favorite.attr.name configuration property.

Description

Use this property to specify the name of an attribute to display within the
summary pane in the Operations Analytics Predictive Insights Managed User
Interface. For example, to display an attribute called “Service”, type the following:
$PI_HOME/bin/admin.sh set t=<topic name> ui.summary.dlg.favorite.attr.name Service

Property configuration information

Table 22. ui.summary.dlg.favorite.attr.name configuration information

Configuration Value

Type STRING

Default

variantInvariant.enabled
variantInvariant.enabled configuration property.

Description

When set to true, this property enables the variant/invariant algorithm to analyze
data and generate alarms.

Property configuration information

Table 23. variantInvariant.enabled configuration information

Configuration Value

Type BOOLEAN

Default TRUE

variantInvariant.maxTrainingWindowDays
The variantInvariant.maxTrainingWindowDays configuration property.

Description

Specifies the maximum amount of data that can be analyzed by the
Variant/Invariant algorithm to train a metric.

Note: The Variant/Invariant algorithm attempts to train when the smallest
maxTrainingWindowDays property for any algorithm, excluding
granger.maxTrainingWindowDays, is reached. To train a metric, the algorithm
requires that the metric has at least 50% data available relative to the value of the
variantInvariant.maxTrainingWindowDays property.
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Property configuration information

Table 24. variantInvariant.maxTrainingWindowDays configuration information

Configuration Value

Type INTEGER

Default 28

Min 7

Max 28

variantInvariant.retrainingIntervalMinutes
The variantInvariant.retrainingIntervalMinutes configuration property.

Description

Specifies the interval, in minutes, at which retraining occurs for the
Variant/Invariant algorithm.

Table 25. variantInvariant.retrainingIntervalMinutes configuration information

Configuration Value

Type INTEGER

Default 1440

Min 0

Max 40320

System properties
The set of system configuration properties for an Operations Analytics Predictive
Insights Managed topic.

System configuration properties are those properties that are not specific to
individual components, such as an algorithm or the User Interface. You can display
all the system properties by using the following command:
admin.sh show -t=<topic>

In the output, the system properties are prefixed with “system”. For example:
system.aggregation.interval: 15
system.alarm.autoclear: true
system.alarm.history.retention.days: 180
system.da.days.before.alarm.cleared: 7
system.da.missing.intervals.before.alarm: 3

Use the set command to set a configuration property:
admin.sh set -t=<topic_name> <property> <value>

For more information about the set command, see “set” on page 92

Note: Restart Operations Analytics Predictive Insights Managed to activate any
changes you make to system configuration properties.

system.aggregation.interval
The system.aggregation.interval configuration property.
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Description

The aggregation interval that is used by the system. Data is normalized to the
same interval so it can be processed by the algorithms. Usually, the aggregation
interval needs to be set to the data collection interval, or to the lowest common
multiple of data collection intervals if the system receives data from several data
sources. Typical values are 5 minutes, 15 minutes, or 1 hour.

Property configuration information

Table 26. system.aggregation.interval configuration information

Configuration Value

Type INTEGER

Default 15

Min 5

Max 60

system.alarm.autoclear
The system.alarm.autoclear configuration property.

Description

If the value of this property is set to true, previous analytics alarms, both
individual and consolidated, are cleared unless they repeat during the next
aggregation interval. However, this property does not affect data availability,
progress, or system health alarms, which are never cleared. If this property is set to
false, alarms are never cleared by the system and remain in OMNIbus or the third
party Event Management system until they are manually cleared by an operator.

Property configuration information

Table 27. system.alarm.autoclear configuration information

Configuration Value

Type BOOLEAN

Default TRUE

system.alarm.history.retention.days
system.alarm.history.retention.days configuration property.

Description

This property sets the number of days data to keep in the alarm history table in
the Operations Analytics Predictive Insights Managed database. Alarms older than
this are purged when the Operations Analytics Predictive Insights Managed Purge
job is run.

Property configuration information

Table 28. system.alarm.history.retention.days configuration information

Type INTEGER

Default 180

Min 0
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Table 28. system.alarm.history.retention.days configuration information (continued)

Max

system.alarm.session.keepalive.hours
system.alarm.session.keepalive.hours configuration property.

Description

Sets the number of hours to reuse an alarm identifier that has been cleared. This
property controls the number of alarms displayed in the Active Event List (AEL)
when a metric becomes anomalous, clears, and becomes anomalous again. With the
default setting, six hours, only one alarm is displayed in the AEL if a metric
becomes anomalous, clears, but becomes anomalous again within six hours of the
initial time it became anomalous.

For example, if a metric is anomalous at 01:00 and again at 05:00, with the default
setting of 6 hours, the AEL has one alarm for the anomalous metric. However, if
the system.alarm.session.keepalive.hours parameter is set to 3 hours, in this
example, the AEL has 2 alarms related to the anomalous metric.

Property configuration information

Table 29. system.alarm.session.keepalive.hours configuration information

Type INTEGER

Default 6

Min 1

Max 72

system.da.days.before.alarm.cleared
system.da.days.before.alarm.cleared configuration property.

Description

The number of days Operations Analytics Predictive Insights Managed data
availability will continue to send alarms for a missing resource and metric group
before clearing the alarm.

Property configuration information

Table 30. system.da.days.before.alarm.cleared configuration information

Configuration Value

Type INTEGER

Default 7

Min 1

Max 100

system.da.missing.intervals.before.alarm
system.da.missing.intervals.before.alarm configuration property.
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Description

The number of intervals Operations Analytics Predictive Insights Managed can be
without data for a resource and metric group before a data availability alarm is
raised.

Property configuration information

Table 31. system.da.missing.intervals.before.alarm configuration information

Configuration Value

Type INTEGER

Default 3

Min 1

Max 1000

system.instance.name
system.instance.name configuration property.

Description

This property sets the SYSTEM instance name.

Property configuration information

Table 32. system.instance.name configuration information

Configuration Value

Type STRING

Default PI

system.max.metricgroups
system.max.metricgroups configuration property.

Description

The maximum number of metric groups that can be configured in a model in the
Operations Analytics Predictive Insights Managed Mediation Tool.

Property configuration information

Table 33. system.max.metricgroups configuration information

Configuration Value

Type INTEGER

Default 50

Min 1

Max 50

system.metric.retention.days
system.metric.retention.days configuration property.
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Description

This sets the number of days to retain the metric values table AND the alarm table
in the Operations Analytics Predictive Insights Managed database. Data and
Alarms older than this are purged when the Operations Analytics Predictive
Insights Managed Purge job is run.

Property configuration information

Table 34. system.metric.retention.days configuration information

Configuration Value

Type INTEGER

Default 15

Min

Max

system.omnibus.enabled
system.omnibus.enabled configuration property.

Description

Set this property to true if OMNIbus is integrated with Operations Analytics
Predictive Insights Managed.

Property configuration information

Table 35. system.omnibus.enabled configuration information

Configuration Value

Type BOOLEAN

Default TRUE

system.timeZone
system.timeZone configuration property

Description

This is used to set the time zone used by the Analytics component if the data in a
topic is from a different time zone to that of the system on which the Operations
Analytics Predictive Insights Managed Analytics component is running.

For example, if the Operations Analytics Predictive Insights Managed Analytics
component is running on a machine in London, but the data is from a source in
New York.

Property configuration information

Table 36. system.timeZone configuration information

Configuration Value

Type String

Default Default
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system.topic.allowNegativeNumbers
system.topic.allowNegativeNumbers configuration property

Description

This value of this property determines how Operations Analytics Predictive
Insights Managed deals with negative numbers. In some environments, negative
numbers are used to represent missing data. When set to false, which is the default
value, negative numbers are treated as missing data. When set to true, negative
numbers are processed in the same way as positive numbers.

Property configuration information

Table 37. system.topic.allowNegativeNumbers configuration information

Configuration Value

Type String

Default False

Log files
The log files that are created by the Operations Analytics Predictive Insights
Managed components.

Analytics log files
v $PI_HOME/log/

v /tmp/streams.spl@scadmin/logs/

Each time Streams stops or starts, the Streams log files are copied from
/tmp/streams.spl@scadmin/logs/ to: $PI_HOME/log/streams.spl@scadmin/logs to
ensure that they are available for future reference. You must remove these files if
Streams is restarted frequently.

Note: The collect.sh script collects wider system information and indicates which
log files can provide more information.

Installation log files
v Installation Manager creates log files in the ⌂/var/ibm/InstallationManager/

logs/ directory.
v The Operations Analytics Predictive Insights Managed installation creates a

/tmp/tasp_install_<datestamp>.log file.
v Problems with the UI installation into JazzSM are logged in the

<JazzSM_Home>/ui/logs/consolecli.log file, where <JazzSM_Home> is typically
/opt/IBM/JazzSM.

UI log files
v The liberty UI creates log files in the <UI_HOME>/wlp/usr/servers/piserver/logs

directory, where <UI_HOME>> is typically /opt/IBM/scanalytics/UI.
v JazzSM profile logs are created in the <JazzSM_Profile_Home>/logs/server1/

directory, where <JazzSM_Profile_Home> is typically /opt/IBM/JazzSM/profile.
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Mediation Tool log files
v On Linux, the Mediation tool logs information in the $PI_HOME/log/

mediationtool.log file.
v On Windows, the workspace folder has a .metadata/.log file.

Database log files
v The DB2 instance owner can view the database log file in the ⌂/sqllib/db2dump/

directory.

Probe log files
v Probe log files are located in $PI_HOME/probe/omnibus/log/<topic>Probe.log,

where <topic> is the name of a topic.

System log files
v The /var/log/messages* files can show system problems such as insufficient

physical memory available.

Using the REST Interface to query Operations Analytics Predictive
Insights Managed data

Operations Analytics Predictive Insights Managed has a REST interface. You can
use this interface to integrate Operations Analytics Predictive Insights Managed
with other applications.

To access the REST interface go to the following URL: https://<server>:9998/
predictiveinsights/rest, where <server> is the server on which Operations
Analytics Predictive Insights Managed is installed.

Datasets

You can use the REST interface to obtain aggregation data for the following
datasets.

Table 38.

Dataset Description Root URL

Alarm Counts by Day Displays the total number of
alarms per day.

https://<IP
address>:9998/
predictiveinsights/rest/
aggregations/alarms-by-day

Alarm Counts by Hour Displays the total number of
alarms per hour.

https://<IP
address>:9998/
predictiveinsights/rest/
aggregations/alarms-by-hour

Top Metrics by Alarm
Counts

Displays the top metrics
ranked by the most number
of alarms.

https://<IP
address>:9998/
predictiveinsights/rest/
aggregations/top-anomalous-
metrics

Top Nodes by Alarm Counts Displays the top nodes
ranked by the most number
of alarms.

https://<IP
address>:9998/
predictiveinsights/rest/
aggregations/top-anomalous-
nodes
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Table 38. (continued)

Dataset Description Root URL

Top Resources by Alarm
Counts

Displays the top resources
ranked by the most number
of alarms.

https://<IP
address>:9998/
predictiveinsights/rest/
aggregations/top-anomalous-
resources

Top Impacting Incidents Displays the top alarms
ranked by the highest
number of consolidated
alarms they represent.

https://<IP
address>:9998/
predictiveinsights/rest/
aggregations/top-incidents

Parameters

You can pass the following parameters in a query that uses the REST interface. To
pass a single parameter, append the parameter prefixed with a question mark, ?, to
the root URL. To pass multiple parameters, prefix the first parameter with ?, and
each subsequent parameter with an ampersand, &.

Table 39. Aggregation Parameters

Name Description Example

topicName Specifies the topic names to
query for data. You can
specify multiple topics
separated by commas. For
example,
topicName=topic1,topic2,topic3.
If this parameter is not
specified then it will query
all topics.

https://192.168.1.2:9998/
predictiveinsights/rest/
aggregations/alarms-by-
day?topicName=network

startTime Specifies the start date and
time for which to query data.
The date and time are
accepted in ISO 8601 format
and can take the following
forms: yyyy-MM-
ddTHH:mm:ss.SSSZ for UTC
or yyyy-MM-
ddTHH:mm:ss.SSSX for time
offset. For example,
2013-05-29T00:00:00.000Z for
UTC or 2013-05-
29T00:00:00.000-05:00 for EST.

https://192.168.1.2:9998/
predictiveinsights/rest/
aggregations/alarms-by-
day?topicName=network
&startTime=2015-10-
27T00:00:00.000Z

endTime Specifies the end date and
time for which to query data.
The date and time are
accepted in ISO 8601 format
and can take the following
forms: yyyy-MM-
ddTHH:mm:ss.SSSZ for UTC
or yyyy-MM-
ddTHH:mm:ss.SSSX for time
offset. For example,
2013-05-29T00:00:00.000Z for
UTC or 2013-05-
29T00:00:00.000-05:00 for EST.

https://192.168.1.2:9998/
predictiveinsights/rest/
aggregations/alarms-by-
day?topicName=network
&startTime=2015-10-
27T00:00:00.000Z
&endTime=2015-10-
30T00:00:00.000Z
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Table 39. Aggregation Parameters (continued)

Name Description Example

timeWindow Specifies a dynamic time
window to query data from.
Valid values are last24Hours,
last7Days, or last30Days.
This parameter is ignored
when startTime and endTime
are specified.

https://192.168.1.2:9998/
predictiveinsights/rest/
aggregations/alarms-by-
hour?last24Hours

num Specifies the number of items
to return in the query result.
The default value is 10 with
a maximum value of 1000.

https://192.168.1.2:9998/
predictiveinsights/rest/
aggregations/alarms-by-
hour?last24Hours&num=8

pretty Returns formatted output
when set to true. Valid
values are true and false.
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Notices

This information was developed for products and services offered in the U.S.A.
IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not give you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785 U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan, Ltd.
1623-14, Shimotsuruma, Yamato-shi
Kanagawa 242-8502 Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE.

Some states do not allow disclaimer of express or implied warranties in certain
transactions, therefore, this statement might not apply to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.
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IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation
2Z4A/101
11400 Burnet Road
Austin, TX 78758 U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurement may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM for the purposes of developing, using, marketing, or distributing application
programs conforming to IBM‘s application programming interfaces.
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If you are viewing this information in softcopy form, the photographs and color
illustrations might not be displayed.
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Trademarks

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the Web at “Copyright and
trademark information” at http://www.ibm.com/legal/copytrade.shtml.

Adobe, Acrobat, PostScript and all Adobe-based trademarks are either registered
trademarks or trademarks of Adobe Systems Incorporated in the United States,
other countries, or both.

Cell Broadband Engine and Cell/B.E. are trademarks of Sony Computer
Entertainment, Inc., in the United States, other countries, or both and is used under
license therefrom.

Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo,
Celeron, Intel Xeon, Intel SpeedStep, Itanium, and Pentium are trademarks or
registered trademarks of Intel Corporation or its subsidiaries in the United States
and other countries.

IT Infrastructure Library is a registered trademark of the Central Computer and
Telecommunications Agency which is now part of the Office of Government
Commerce.

ITIL is a registered trademark, and a registered community trademark of the Office
of Government Commerce, and is registered in the U.S. Patent and Trademark
Office.

Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Sun Microsystems, Inc. in the United States, other countries,
or both.

Linux is a trademark of Linus Torvalds in the United States, other countries, or
both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Other company, product, and service names may be trademarks or service marks
of others.

For trademark attribution, visit the IBM Terms of Use Web site
(http://www.ibm.com/legal/us/).
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